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Who Should Read This Guide 

This guide is intended for single domain owners, who were provided with access to 
Plesk control panel as part of their shared or dedicated hosting package. 

Typographical Conventions 

The following kinds of formatting in the text identify special information. 

Formatting convention Type of Information Example 

Special Bold 

 

Items you must select, such as 
menu options, command 
buttons, or items in a list. 

Go to the QoS tab. 

Titles of chapters, sections, 
and subsections. 

Read the Basic Administration 
chapter. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to 
designate a command line 
placeholder, which is to be 
replaced with a real name or 
value. 

The system supports the so 
called wildcard character 
search. 

Monospace The names of style sheet 
selectors, files and directories, 
and CSS fragments.  

The license file is located in the 
httpdocs/common/license 

directory. 

Preformatted On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

# ls –al /files 

total 14470 

Preformatted Bold What you type, contrasted with 
on-screen computer output. 

# cd /root/rpms/php 

 
 

C H A P T E R  1  

Preface 
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Feedback 

If you have found a mistake in this guide, or if you have suggestions or ideas on how to 
improve this guide, please send your feedback to userdocs@swsoft.com. Please 
include in your report the guide's title, chapter and section titles, and the fragment of 
text in which you have found an error. 

mailto:userdocs@swsoft.com
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In this chapter: 

Logging In to Plesk ............................................................................................ 9 
Becoming Familiar with Plesk's Interface........................................................... 10 
Changing Your Contact Information and Password ........................................... 12 
 
 

Logging In to Plesk 

 To log in to your Plesk control panel: 

1 Open your web browser, and in the address bar type the URL where 
your Plesk control panel is located (for example, 
https://your.domain.com:8443). 

2 Press ENTER.  

Plesk login screen will open. 

3 Type the login name and password your provider gave you into the 
Login and Password boxes, respectively.  

Your login name would be your domain name. 

4 If you log in for the first time, select the language for your control 
panel from the Interface language drop-down box.  

If you had previously specified the interface language and saved it in your interface 
preferences, leave the User default value selected. 

5 Click Login. 
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Getting Started 

https://your.domain.com:8443/
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Becoming Familiar with Plesk's Interface 

When you log in to control panel, it can open in either a standard view, a simplified 
desktop view, or a combination of both. The standard view is a customary view of the 
control panel divided into two main areas: navigation pane on the left and the main 
screen where operations are performed on the right. 

 

Figure 1: Domain administrator's standard interface 

The desktop view can show site statistics and shortcuts to the operations you 
frequently perform—everything you may need can now be accessible from a single 
screen. 

 

Figure 2: Domain administrator's Desktop 
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Items in the Standard View 

The navigation pane is located on the left. It gives you access to sets of administrative 
functions: 

 Home. Web site and e-mail administration tools. You will spend most of the time in 
this area. 

 Sessions. Management of your mail users’ sessions in the control panel and FTP 
connections to your host. For more information on managing sessions, refer to 
chapter Monitoring Connections to Control Panel and FTP Services (on page 124). 

 Log Out. When finished working with control panel, click this icon to end your 
session. 

 Help Desk. Use it to report your problems to server administrator or provider’s 
technical support. For more information on this feature, refer to chapter Using Help 
Desk for Requesting Assistance From Service Provider (on page 127). 

 Help. Provides context sensitive help. 

Below the Help icon, there is a context help tip area. It provides a brief description of the 
current screen or available operations. When you place the mouse pointer over a 
system element or status icon, it displays additional information. 

To navigate through Plesk, you can also use a path bar: a chain of links that appears in 
the right part of the screen, below the banner area. To return to a previous screen, click 

 Up Level in the upper-right corner of the screen. 

To find items in lengthy lists, use search boxes located above every list of items: type a 
search criterion into the input box, and click Search. A list will show the items matching 
the search criteria. To return back to viewing all items, click Show All. You can hide the 
search area by clicking Hide Search. To show the hidden search area, click Show Search. 

To sort a list by a certain parameter in ascending or descending order, click on the 
parameter's title in the column heading. The order of sorting will be indicated by a small 
triangle displayed next to the parameter's title. 

To customize your control panel in the Standard view, refer to the Customizing Your 
Control Panel in the Standard View (on page 13) section. 

Items in the Desktop View 

The desktop view originally shows three sections: 

 Tools. This group shows shortcuts to the operations that you can perform through 
the control panel. You can freely add and remove these shortcuts. 

 Statistics. This shows the number of e-mail accounts you have under your domain, 
disk space and montly bandwidth usage, and number of served subdomains (parts 
of your main site or separate sites under your parent domain). 
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 Favorites. This group shows three types of shortcuts sorted by type and placed on 
the respective tabs. The Mailnames tab shows shortcuts to the favorite e-mail 
accounts. The Shortcuts tab shows all other types of shortcuts that do not relate to 
e-mail user accounts. The Recent tab shows last ten control panel screens you have 
been on. The Favorites group also provides search tool for finding e-mail accounts. 
To use the search tool, type the search criteria (this can be any combination of 

symbols, search is case insensitive) and click  Search.    

To customize your control panel in the Desktop view, refer to the Customizing Your 
Control Panel in the Desktop View (on page 15) section. 

Using Wizards 

When you work with Plesk in the Desktop view, you accomplish the tasks you need 
through wizards. Each wizard is a series of consecutive screens. To accomplish a task 
using a wizard, follow the instructions displayed on the wizard screens. For information 
on individual options, refer to the respective sections of this guide. 

Changing Your Contact Information and 
Password 

 If you need to update your contact information, or change password: 

1 Click Domain Administrator in the Domain group. 

2 Update your information as required, or type a new password, and 
click OK.  

 

 If you forgot your password: 

1 In your web browser’s address bar, type the URL where your Plesk 
control panel is located. For example, https://your.domain.com:8443. 

2 Press ENTER.  

Plesk login screen will open. 

3 Click the Forgot your password? link. 

4 Type your domain name into the Login box, and type your e-mail 
address registered in the system into the E-mail box.  

5 Click OK.  

Your password will be sent to your e-mail address. 

 

 

https://your.domain.com:8443/
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In this chapter: 

Customizing Your Control Panel in the Standard View ...................................... 13 
Customizing Your Control Panel in the Desktop View ....................................... 15 
 
 

Customizing Your Control Panel in the 
Standard View 

Setting Interface Language and Skin for Your Control Panel 

 To select an interface language and theme (skin) for your control panel: 

1 On your Home page, click Domain Administrator in the Domain group. 

2 In the Preferences group, select the desired interface language and skin 
from the respective drop-down boxes.  

Plesk’s interface has been translated to a number of different languages, so if you 
do not see your own language in the list, ask your provider to install the respective 
language pack. You can also change your contact information here. For instructions 
on how to change your contact information, refer to the Changing Your Contact 
Information (on page 12) section. 

3 Click OK. 
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Adding a Hyperlink Button to Your Control Panel 

 To add a custom hyperlink button to your Plesk control panel: 

1 Click Custom Buttons in the Domain group. 

2 Specify properties of the button: 

 Type the text that will show on your button in the Button label field. 

 Choose the location for your button. To place it in the right frame of your Home 
page, select the Domain Administration page value as the location. To place it in 
the left frame (navigation pane) of your control panel, select the Navigation pane 
value. 

 Specify the priority of the button. Plesk will arrange your custom buttons on the 
control panel in accordance with the priority you define: the lower the number – 
the higher is priority. Buttons are placed in the left-to-right order. 

 To use an image for a button background, type the path to its location or click 
Browse to browse for the desired file. It is recommended that you use a 16x16 
pixels GIF or JPEG image for a button to be placed in the navigation pane, and 
32x32 pixels GIF or JPEG image for buttons placed in the main frame. 

 Type the hyperlink of your choice to be attached to the button into the URL field. 

 Using the checkboxes, specify whether to include the data, such as domain id 
and domain name to be transferred within the URL. These data can be used for 
processing by external web applications. 

 In the Context help tip contents input field, type in the help tip that will be displayed 
when you hover the mouse pointer over the button. 

 Select the Open URL in the Control Panel checkbox if you wish the destination URL 
to be opened in the control panel's right frame, otherwise leave this checkbox 
unchecked to open the URL in a separate browser window. 

 If you wish to make this button visible to the mailbox users with access to control 
panel, select the Visible to all sub-logins checkbox. 

3 Click OK to complete creation. 

 
 

Removing a Hyperlink Button from Your Control Panel 

 To remove a hyperlink button from your Plesk control panel: 

1 Click Custom Buttons in the Tools group. 

2 Select a check box corresponding to the button that you wish to 
remove.  

3 Click  Remove Selected. Confirm the removal and click OK. 
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Customizing Your Control Panel in the 
Desktop View 

 To add or remove items from the desktop: 

1 Go to Desktop >  Customize Desktop. 

2 In the Tools group, specify what tasks you would like to accomplish 
through the control panel. The appropriate shortcuts will be placed to 
the desktop. The Selected tasks list shows the tasks for which shortcuts 
are already placed on the desktop. The Available tasks list shows the 
tasks for which you do not yet have shortcuts on your desktop.  

 To add a shortcut to the desktop, select the required tasks in the Available tasks 
list and click Add >>. 

 To remove a shortcut from the desktop, select the task that you do not need in 
the Selected tasks list and click << Remove. 

3 To show your custom buttons on the desktop, select the Custom buttons 
check box. 

4 To show the shortcut for creating new custom hyperlink buttons at the 
bottom of the desktop, select the Create a new domain custom button check 
box. 

5 Specify whether to show the Statistics and Favorites groups and what 
items to show there. Clearing check boxes will remove the respective 
items from the desktop. The Favorites group shows the links to items or 
control panel screens that you added to desktop by navigating to the 

respective control panel screens and clicking  Create shortcut or  Add 
to favorites. 

6 Click OK. 

 

 To add a mail account to the Favorites group of the desktop: 

1 Go to Mail > e-mail address and click  Add to favorites in the upper right 
corner of the screen. 

2 Specify the desktop shortcut label and the description.  

3 Click OK. 

 

 To add items to the Favorites group of the desktop: 

1 Navigate to the control panel screen you need. 

2 Click  Create Shortcut in the upper right corner of the screen. 

3 Specify the desktop shortcut label and the description.  

4 Click OK. 
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 To remove items from the Favorites group of the desktop: 

1 On the desktop, click the shortcut that you wish to remove. 

2 Click  Edit Favorites in the upper right corner of the screen. 

3 Click Remove. 

OR 

1 On the desktop, click the  icon corresponding to the shortcut that 
you wish to remove. 

2 Click Remove. 
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 To review or select the hosting features available for your account (if your provider 
delegated the permission to manage the hosting options for your account): 

1 Click Setup on your Home page. 

2 View or change your physical hosting settings:  

 IP Address. Your domain can be hosted on either exclusive IP address or shared 
IP address. Choose an address from your service provider's IP addresses pool. 

 Certificate. Shows the SSL certificate used by your domain. 

 SSL support. Secure Sockets Layer encryption is generally used for protecting 
transfer of sensitive data during online transactions on e-commerce Web sites 
that run on dedicated IP addresses. SSL certificates that participate in the 
encryption process are usually applied to a single domain name on a single IP 
address, therefore, each site that needs SSL protection must be hosted on a 
dedicated IP address. An exception to this is subdomains, which you can 
protect with a wildcard certificate. Installing an SSL certificate on a Web server 
that hosts several web sites with different domain names on a single IP address 
(shared or name-based hosting) is technically possible, however, it is not 
recommended: the encryption will be provided, but users will get warning 
messages on attempt to connect to the secure site. To allow SSL encryption for 
Web sites, select the SSL support check box. 

 FTP/Microsoft FrontPage Login and FTP/Microsoft FrontPage password. Specify the 
user name and password that will be used for publishing the site to the server 
through FTP. Retype the password into the Confirm Password box. 

 Hard disk quota. Specify the amount of disk space in megabytes allocated to the 
web space for this site. This is the so-called hard quota that will not allow writing 
more files to the web space when the limit is reached. At attempt to write files, 
users will get the "Out of disk space" error. Hard quotas should be enabled in 
the server's operating system, so if you see the "Hard disk quota is not 
supported" notice to the right of the Hard disk quota field, but would like to use the 
hard quotas, contact your provider or the server administrator and ask to enable 
the hard quotas. 

 Access to system. This allows you to directly access the system through a 
Remote Desktop connection. However, allowing system access via RDP also 
poses a potential threat to the server security, so we recommend that you do 
not allow it, leaving the Login prohibited option selected. 

 SiteBuilder support. SiteBuilder is an efficient and user-friendly WYSIWYG web 
site editor running through the web interface. Leave the Publish site with 
SiteBuilder checkbox selected to be able to access SiteBuilder and build web site 
through your Plesk control panel interface by clicking SiteBuilder on the domain 
management page. The version of SiteBuilder coming in the standard Plesk 
distribution is fully functional and its use is not limited in any way by the 
manufacturer (but you can be restricted from accessing it by your service 
provider). 
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 Microsoft FrontPage support. Microsoft FrontPage is a popular web site authoring 
tool. To enable publishing and modifying the site through Microsoft FrontPage, 
select the Microsoft FrontPage support and Microsoft FrontPage over SSL support 
check boxes, and set the Remote Microsoft FrontPage authoring option to allowed. 

Note. Microsoft FrontPage over SSL support is available only when SSL 
support is enabled on a domain. 

 Support for programming and scripting languages widely used in development of dynamic 
Web sites and server-side Web applications. Specify which of the following  
programming and scripting languages should be interpreted, executed or 
otherwise processed by the web server: Active Server Pages (ASP), Active 
Server Pages on .NET framework (ASP.NET), Server Side Includes (SSI), PHP 
hypertext preprocessor (PHP), Common Gateway Interface (CGI), Perl, Python, 
ColdFusion and Miva scripting required for running Miva e-commerce solutions. 

Note. If ASP.NET support is enabled, ASP.NET version 2.0 is set as default. 

You can change the version in the corresponding drop-down menu. 

If PHP support is enabled, PHP version 4 is set as default. You can change the 
version in the corresponding drop-down menu 

 Web statistics. To allow you to view the information on the number of people 
visited the site and the pages of the site they viewed, select a module in Web 
statistics drop-down menu and select the accessible via password protected directory 
/plesk-stat/ checkbox, if required. This will install the selected statistical software 
module, which will generate reports and place them into the password protected 
directory. The domain administrator will then be able to access Web statistics at 
the URL: https://your-domain.com/plesk-stat/ using their FTP account login and 
password. 

 Custom error documents. When visitors coming to your site request pages that the 
web server cannot find, the web server generates and displays a standard 
HTML page with an error message. If you wish to create your own error pages 
and use them on your web server, select the Custom error documents check box. 

Note. You can enable the support for all programming and scripting languages, 
web statistics and custom error documents at once by selecting All services 
checkbox in the Services group. 

 Additional write/modify permissions. This option is required if your web applications 

are using a file-based database (like Jet) located in the root of httpdocs or 

httpsdocs folders. Please note that this option might seriously compromise 

the web site security 

 Use dedicated IIS application pool. This option enables the use of dedicated IIS 
application pool for your web applications. Using dedicated IIS application pool 
dramatically improves the stability of your web applications due to worker 
process isolation mode. This mode gives each web site hosted on the server the 
possibility to allocate a separate process pool for execution of its web 
applications. This way, malfunction in one application will not cause stopping of 
all the others. This is especially useful when you are using shared hosting 
package. 

3 Click OK. 

 

https://your-domain.com/plesk-stat/
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Viewing the Resource Allotments 

 To see the amount of resources your site can consume:  

1 Click Limits in the Domain group. 

2 The following resources usage allotments can be viewed: 

 Maximum number of domain aliases. Displays the maximum number of domain 
aliases that can be created for your domain. 

 Maximum number of subdomains. Displays the maximum number of subdomains 
that can be hosted under your domain. 

 Disk space. Shows you the total amount of disk space allocated to your hosting 
account. This amount is measured in megabytes. It includes disk space 
occupied by all files related to this domain/web site: web site contents, 
databases, applications, mailboxes, log files and backup files. This is the so-
called soft quota: when it is exceeded, domain names and web sites are not 
suspended automatically, only the appropriate notices are sent to your 
provider's e-mail addresses and the resource overage is indicated by a 

corresponding icon  shown in the control panel to the left of your domain 
name. When your website required more disk space, consider upgrading your 
hosting plan. 

 MySQL databases quota and Microsoft SQL databases quota. Displays the maximum 
disk space amount that MySQL and Microsoft SQL Server databases 
respectively can occupy on your domain. 

 Maximum amount of traffic. Displays the maximum amount of data in megabytes 
that can be transferred from the web site during a month. Once the limit is 
reached, the appropriate notices are sent to your provider's e-mail addresses 

and the resource overage is indicated by a corresponding icon  shown in the 
control panel to the left of the domain name. When your web site starts 
attracting more visitors and requires more bandwidth, consider upgrading your 
hosting plan. 

 Maximum number of web users. Shows the maximum number of personal web 
pages that you can host for other users under your domain. This service is 
mostly used in educational institutions that host non-commercial personal pages 
of their students and staff. These pages usually have web addresses like 
http://your-domain.com/~username. If the Allow the web users scripting check box 
is selected, execution of scripts embedded in personal web pages is allowed. 
See the Hosting Personal Web Pages on Your Web Server (on page 73) section 
for details. 

 Maximum number of additional Microsoft FrontPage accounts. Displays the maximum 
number of additional Microsoft FrontPage accounts you can create on your 
domain. 

 Maximum number of additional FTP accounts. Displays the maximum number of 
additional FTP accounts you can create on your domain. 

 Maximum number of MySQL databases and Maximum number of Microsoft SQL server 
databases. Displays the maximum number of MySQL and Microsoft SQL Server 
databases respectively that can be hosted in your domain. 

http://your-domain.com/~username
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 Maximum number of mailboxes. Shows the maximum number of mailboxes that can 
be hosted in your domain. 

 Mailbox quota. Displays the amount of disk space in kilobytes that is allocated to 
each mailbox in your domain.  

 Total mailboxes quota. Displays the total amount of disk space available for all 
mailboxes on a domain. 

 Maximum number of mail redirects. Shows the maximum number of mail redirects 
that can be used in your domain. 

 Maximum number of mail groups. Shows the maximum number of mail groups that 
can be used in your domain. 

 Maximum number of mail autoresponders. Displays the maximum number of 
autoresponders that can be set up in your domain. 

 Maximum number of mailing lists. Shows maximum the number of mailing lists that 
you can run in a domain. 

 Maximum number of Java applications. Displays the maximum number of Java 
applications or applets that you can install in a domain. 

 Maximum number of shared SSL links. Shows the total number of subdomains 
(including their parent domain) that can link to the Master SSL domain defined 
by the server administrator. 

 Maximum number of ODBC connections. Shows the maximum number of ODBC 
connections that you can set up on your domain. 

 Validity period. Shows the term for a hosting account. At the end of the term, your 
domain/web site will be suspended, its Web, FTP and mail services will no 
longer be accessible to the Internet users, and you will not be able to log in to 
the control panel.  

3 Click OK. 
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Viewing the Permissions for Operations 

 To view the permissions for operations you can perform through your control panel: 

1 Click Domain Administrator on your Home page. 

2 The permissions are listed in the Permissions group: 

 Physical hosting management. Shows whether you can fully control hosting 
account for your web site. 

 Hard disk quota assignment. Shows whether you can set up the hard quota on disk 
space allocated to your site. 

 Subdomains management. Shows whether you can set up, modify and remove 
subdomains in your domain. 

 DNS zone management. Shows whether you can manage  the DNS zone of your 
domain. 

 Log rotation management. Shows whether you can adjust the cleanup and 
recycling of processed log files for your site. 

 Scheduler management. Shows whether you can schedule tasks with the task 
scheduler. Scheduled tasks can be used for running scripts or utilities on 
schedule. 

 Anonymous FTP management. Shows whether you can have an FTP directory 
where all users could download and upload files without the need to enter login 
and  password. A web site should reside on a dedicated IP address in order to 
use anonymous FTP service. 

 FTP accounts management. Shows whether you can create additional FTP 
accounts for your web site. 

 Tomcat applications management. Shows whether you can install Java applications 
and applets on your web site through the control panel. 

 System access management. Shows whether you can enable and disable access to 
the system through Remote Desktop. 

 Mailing lists management. Shows whether you can use mailing lists provided by the 
GNU Mailman software. 

 Backup/restore functions. Shows whether you can use the control panel's facilities 
to backup and restore your site. Scheduled and on-demand backups are 
supported. 

 Spam filter management. Shows whether you can use spam filter provided by the 
SpamAssassin software. 

 Antivirus management. Shows whether you can use antivirus protection for filtering 
incoming and outgoing mail. 

 SiteBuilder. Shows whether you can use SiteBuilder for creating and editing your 
web site. 

 Hosting Perfomance Management. Shows whether you can change the hosting 
performance preferences for your domain. 
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 IIS Application Pool Management. Shows whether you can manage your IIS 
application pool. 

 Web statistics management. Shows whether you can manage web statistics for 
your domain. 

 Additional write/modify permissions management. Shows whether you can manage 
additional write/modify permissions for your domain. These permissions are 
required if your web applications are using a file-based database (like Jet) 

located in the root of httpdocs or httpsdocs folders. Please note that 

selecting this option might compromise web site security. 

 User interface. Shows what type of Plesk control panel interface you can use - 
standard, desktop, or both. 

 Desktop management. Shows whether you can customize and manage your 
desktop interface. 

3 Click OK. 
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Once you have registered your domain name, constructed your web site, and 
purchased a hosting package from your hosting service provider, you can: 

 Publish your site to your web space on the provider’s server, 

 Deploy databases and applications that your web server will be using, 

 Secure data transfer with Secure Sockets Layer encryption and restrict access to 
web server resources with password protection. 
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Publishing Your Site 

Publishing your site means uploading web pages, scripts and graphic files that 
compose the site to your web space in any of the following ways: 

 Through FTP connection 

 Through Plesk File Manager 

 Through Through Adobe Dreamweaver or Microsoft FrontPage software 

 Through SiteBuilder 

FTP is one of the most common and easiest ways to upload files. 

 
 

Uploading Site Through FTP 

 To upload your site through FTP: 

1 Connect to the server with an FTP client program, using FTP account 
credentials your provider gave you.  

Enable the passive mode if you are behind a firewall. 

2 Upload files and directories that should be accessible through HTTP 

protocol to the httpdocs directory, and files/directories that should 

be transferred securely over SSL protocol to the httpsdocs 

directory.  

3 Place your CGI scripts into the cgi-bin directory. 

4 Close your FTP session. 

 
 

Changing Your FTP Account Credentials 

 To change the user name and password for accessing your FTP account: 

1 On your Home page, click Setup. 

2 Specify the new FTP login name and password. 

3 Click OK. 
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Using Additional FTP Accounts 

If you are working on your web site together with someone else or host subdomains for 
other users, you might want to create additional FTP accounts. 

Creating Additional FTP Accounts 

 To create an additional FTP account: 

1 On your Home page, click FTP Accounts in the Hosting group. 

2 On the Additional FTP Accounts tab, click Add New FTP Account.  

3 Specify the FTP account name in the appropriate field. 

4 Specify the Home directory by clicking  and select the directory 
required. Alternatively, you can specify the path in the input field.  

5 Type the new password into the New password and Confirm password 
boxes. 

6 By default, the Hard disk quota is set to Unlimited. To set the required 
parameter, clear the Unlimited checkbox and type the amount of disk 
space in megabytes into the Hard disk quota box. 

7 If required, select the Read permission checkbox. The FTP account 
users will be able to view the content of the home directory and 
download files from it.    

8 If required, select the Write permission checkbox. The FTP account 
users will be able to create, view, rename and delete directories in the 
home directories. 

If you don't grant any permissions, the connection to the FTP account will be made, 
but the home directory will be not displayed for users.  

9 Click OK. A new additional FTP account will be added.  
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Changing Settings of Additional FTP Accounts 

 To change the properties of an additional FTP account:  

1 On your Home page, click FTP Accounts in the Hosting group. 

2 On the Additional FTP Accounts tab, click the required account in the list.   

3 Specify the FTP account name in the appropriate field. 

4 Specify the Home directory by clicking  and select the directory 
required. Alternatively, you can specify the path in the input field.  

5 Type the new password into the New password and Confirm password 
boxes. 

6 By default, the Hard disk quota is set to Unlimited. To set the required 
parameter, clear the Unlimited checkbox and type the amount of disk 
space in megabytes into the Hard disk quota box. 

7 If required, select the Read permission checkbox. The FTP account 
users will be able to view the content of the home directory and 
download files from it.    

8 If required, select the Write permission checkbox. The FTP account 
users will be able to create, view, rename and delete directories in the 
home directories. 

If you don't grant any permissions, the connection to the FTP account will be made, 
but the home directory will be not displayed for users.  

9 Specify the changes as required and click OK. 
 

Removing Additional FTP Accounts 

 To remove an additional FTP account: 

1 On your Home page, click FTP Accounts in the Hosting group. 

2 On the Additional FTP Accounts tab, select the checkbox corresponding to 

the account you want to remove and click  Remove Selected. 

3 Confirm removal and click OK. The FTP account will be removed. 
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Uploading Site Through Plesk File Manager 

 To upload sites through Plesk File Manager: 

1 Log in to Plesk control panel into your domain administrator’s 
account. 

2 Click File Manager in the Hosting group. 

3 Create and upload files and directories.  

Place the files and directories that should be accessible via HTTP protocol to the 

httpdocs directory, and files/directories that should be transferred securely over 

SSL protocol to the httpsdocs directory. Place your CGI scripts into the cgi-bin 

directory. 

 To create a new directory within your current location, click Add New Directory in 
the Tools group, specify the directory name and click OK. 

 To create new files in the required directory, click Add New File in the Tools group, 
in the File creation section specify the file name, select the Use html template check 
box, if you want file manager to insert some basic html tags to the new file, and 
click OK. A page will open allowing you to enter the content or html-formatted 
source of a new file. After you are done, click OK. 

 To upload a file from the local machine, click Add New File in the Tools group, 
specify the path to its location in the File source box (or use Browse to locate the 
file), and click OK.  

 To view or edit an existing file, click its name. When editing an HTML file, Plesk 
opens internal WYSIWYG editor by default. If you want to edit the source code 
of the HTML file, click Html. To return back to WYSIWYG mode, click Design. 

When you upload web content through File Manager or FTP, your control panel 
automatically sets the appropriate access permissions for files and directories. To 

change the permissions of files and directories, click . For more information about 
the system of permissions, refer to the Setting Up Access Permissions for Files and 
Folders (on page 88) section. 

To preview a Web page in your browser, click . 

To rename a file or directory, click . Type in a new name and click OK. 

To copy or move a file or directory to another location, select the required file or 

directory using the appropriate check box, and click  Copy/Move. Specify the 
destination for the file or directory to be copied or renamed to, then click Copy to copy, 
or Move to move it. 

To update the file or directory creation date, click  Change Timestamp. The time stamp 
will be updated with the current local time. 

To calculate the size of selected files, select the checkboxes corresponding to the files 

which size you wish to see and click  Size. 

To remove a file or directory, select the corresponding check box, and click  Remove 
Selected. Confirm removal and click OK. 
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Publishing Sites From Microsoft FrontPage 

Microsoft FrontPage deals with two kinds of Web sites: disk-based and server-based. 
In short, a disk-based site is a FrontPage Web site you create on your local hard disk 
and then later publish to a Web server. A server-based site is one you create and work 
with directly on a Web server, without the extra step of publishing. This section 
provides you with instructions on publishing only disk-based web sites. 

You can publish disk-based web sites either through FTP or HTTP. If your server is 
running FrontPage Server Extensions, you would publish your site to an HTTP location. 
For example: http://your-domain.com/MyWebSite. If your server supports FTP, you 
would publish to an FTP location. For example: ftp://ftp.your-domain.com/myFolder. 

To find out which publishing method your server supports, contact your hosting 
company, or your IT department. 

After publishing, you can manage your site through FrontPage Server Extensions.  

 To access Microsoft FrontPage Server Extensions management interface: 

1 Log in to Plesk. 

2 Click FrontPage Management.and click one of the following icons: 

 Click FrontPage WebAdmin to manage a site, which is not protected by SSL. 

 Click FrontPage-SSL WebAdmin to manage an SSL-enabled site. 

3 Type your Microsoft FrontPage administrator’s login name and 
password, and click OK. 

For instructions on using FrontPage Server Extensions, see online help (FP WebAdmin > 
Help) or visit Microsoft web site.  
 

http://your-domain.com/MyWebSite
ftp://ftp.your-domain.com/myFolder
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Publishing Sites From Microsoft FrontPage Through FTP 

If you are publishing from a computer at work, ask your IT department, help desk, or 
network administrator if you are allowed to publish with FTP beyond a firewall. Also ask 
if you need to install special software that allows you to publish beyond the firewall. 

 To publish files through FTP: 

1 Open Microsoft FrontPage. 

2 Open a Microsoft  FrontPage Web site: open File menu and select the 
Open Site item. 

3 Go to Remote Web site view: click the Web Site tab, and then the Remote 
Web Site button at the bottom of the window. 

4 Set up your Remote Web Site Properties: 

 Click the Remote Web Site Properties button in the upper-right corner of the 
window. 

 Select FTP as the remote Web server. 

 In the Remote Web site location box, type your host name (e.g., ftp://ftp.your-
domain.com) 

 In the FTP directory box, type your FTP directory if your hosting company 
provided one. Leave it blank if they did not specify one. 

 Select the Use Passive FTP check box if your computer or network is protected by 
a firewall.  

5 Click OK to connect to the remote site.  

The Remote Web site view will show files that you have in your local and remote 
sites. 

6 Click the Publish Web site button in the lower-right corner of the window. 

 
 

ftp://ftp.your-domain.com/
ftp://ftp.your-domain.com/


 

 Setting Up And Maintaining Your Web Site 31 

 

Publishing Sites From Microsoft FrontPage Through HTTP 

 To publish files through HTTP on a server that supports FrontPage Server Extensions: 

1 Open your FrontPage program. 

2 Open a FrontPage Web site: open File menu and select the Open Site 
item. 

3 Go to Remote Web site view: click the Web Site tab, and then the Remote 
Web Site button at the bottom of the window. 

4 Click the Remote Web Site Properties button in the upper-right corner of 

the window. 

5 On the Remote Web Site tab, under Remote Web server type, click FrontPage or 
SharePoint Services. 

6 In the Remote Web site location box, type the Internet address, including 
the protocol, of the remote Web site that you want to publish folders 
and files to — for example, http://www.your-domain.com — or click 
Browse to locate the site. 

7 Do any of the following:  

 To use Secure Sockets Layer (SSL) for establishing a secure communications 
channel to prevent the interception of critical information, click Encryption 
connection required (SSL). To use SSL connections on your Web server, the 
server must be configured with a security certificate from a recognized certificate 
authority. If the server does not support SSL, clear this check box. Otherwise, 
you will not be able to publish folders and files to the remote Web site. 

 To remove specific types of code from Web pages as they are being published, 
on the Optimize HTML tab, select the options you want. 

 To change the default options for publishing, on the Publishing tab, select the 
options you want. 

8 Click OK to connect to the remote site.  

The Remote Web site view will show files that you have in your local and remote sites. 

9 Click the Publish Web site button in the lower-right corner of the window. 
 

http://www.your-domain.com/
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Changing Microsoft FrontPage Settings 

If you want Microsoft FrontPage to use its own IIS Index Server to build the full-text 
index of your Web site. 

 To make Microsoft FrontPage use its own IIS Index Server: 

1 From your Home page go to FrontPage Management > Preferences. 

2 Select Use the IIS Index Server check box and click OK. 

 

If you use FrontPage forms that submit information by e-mail on your site, you may 
want to specify the following preferences: 

 SMTP mail server that will be used for sending mail. By default, SMTP server specified in 
the domain's DNS zone is used for sending mail. If no SMTP server is specified in 
the zone, then FrontPage uses the mail service running on the server where the 
domain (site) is hosted. 

 Sender's e-mail address. By default, domain owner's e-mail address is used. If the 
domain owner's e-mail address is not specified in domain owner's profile, then 
FrontPage uses the e-mail address of the client, to whom the domain belongs. If the 
client's e-mail address is not specified in the client's profile, then the server 
administrator's e-mail address is used. 

 To change the preferences: 

1 From your Home page go to FrontPage Management > Preferences. 

2 Under Mail Settings specify the SMTP server and the e-mail address 
you want to use, and then click OK.   
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Using Additional Microsoft FrontPage Accounts 

If you are working on your web site together with someone else or host subdomains for 
other users, you might want to create additional Microsoft FrontPage accounts. 

Creating Additional Microsoft FrontPage Accounts 

 To create an additional Microsoft FrontPage account: 

1 Click FrontPage Management on your Home page. 

2 Click Add New FrontPage Account. 

3 Specify the login and password for this account. 

4 If you wish to limit the amount of disk space that can be used by this 
account, clear the Unlimited checkbox and type the desired value in 
megabytes into the Hard disk quota box. 

When the specified limit is exceeded, the account owner will not be able to add files 
to his or her web space. 

5 Click OK to finish the creation of an additional Microsoft FrontPage 
account. 

 
 

Changing Settings of Additional Microsoft FrontPage Accounts 

 To change settings for an additional Microsoft FrontPage account: 

1 Click FrontPage Management on your Home page. 

2 Click the required account in the list. 

3 Specify new login and password for this account. 

4 Adjust the limit on the amount of disk space that can be used by this 
account by specifying the new limit in the Hard disk quota box.  

When the specified limit is exceeded, the account owner will not be able to add files 
to his or her web space. 

5 Click OK to save changes. 

 
 

Removing Additional Microsoft FrontPage Accounts 

 To remove an additional Microsoft FrontPage account: 

1 Click FrontPage Management on your Home page. 

2 Select the checkbox corresponding to the account you wish to 
remove. 

3 Click  Remove Selected. 

4 Confirm the removal and click OK. 
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Publishing Sites From Adobe Dreamweaver 

Before publishing a site from Dreamweaver, you need to define the site properties, that 
is, you need to tell Dreamweaver where your site files are located on your computer, 
and to specify the server to which you want to publish the site. 

 To define a site in Dreamweaver: 

1 From the Site menu, choose New Site. The Site Definition screen opens. 

2 Click the Advanced tab. 

3 In the Local Info category, specify the following: 

 Site name. This will show in Web browser’s title bar. 

 Local root folder. This is the folder on your computer where all of your site files 

are stored. For example c:\My Site 

 Default images folder. Specify the folder where your site’s graphic files are stored. 

For example c:\My Site\images 

 HTTP address. Specify your domain name. For example, http://your-
domain.com 

4 From the Category menu, select the Remote Info item. 

5 From the Access menu, select the FTP option. Most likely, your server 
supports publishing through FTP (File Transfer Protocol, commonly 
used for transferring files over the Internet).  

6 Specify the following settings: 

 FTP host. Type your FTP host name without the ftp:// prefix. For example, 

your-domain.com. 

 Host directory. Specify the directory on the server where your site will reside. In 

most cases, this is httpdocs. 

 Login and password. Specify the login name and password that your provider 
gave you. 

 Use passive FTP. Select this option only if your computer is behind a firewall. 

7 To ensure that you specified the correct login and password, and that 
Dreamweaver can connect to the server, click the Test button. 

8 To save the settings, click OK. 

 

 To publish your site: 

1 Open your site in Dreamweaver. 

2 From the Site menu, select the Put option (or press Ctrl+Shift+U 
simultaneously).  

 

http://your-domain.com/
http://your-domain.com/
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Publishing Site From SiteBuilder 

 To publish your website from SiteBuilder: 

1 Log in to your control panel. 

2 Click Setup on your Home page and verify that Publish Site with SiteBuilder 
checkbox is selected. Click OK to return to your Home page. 

3 Click SiteBuilder Wizard. 

4 After SiteBuilder is loaded, follow the instructions provided in 
SiteBuilder documentation to publish your website. You can find 
SiteBuilder documentation at 
http://www.swsoft.com/en/products/sitebuilder/win/docs/ 
(http://www.swsoft.com/en/products/sitebuilder3win/docs). 

 
 

Previewing Your Site 

Once you published your site to your web space, you may want to make sure that it 
functions properly in the actual hosting environment. You can preview your site through 
your favorite web browser, even if the information on your domain name has not yet 
propagated in the Domain Name System. Note that Macromedia Flash and CGI scripts 
will not work during preview. 

To preview your site, on your Home page, click Site Preview in the Hosting group. 
 

Configuring ASP.NET 

ASP.NET is a flexible set of tools and web development technologies that allows you to 
employ a number of  applications based on ASP.NET framework. Plesk supports both 
1.1.x and 2.0.x versions of the .NET framework and allows configuring most of its 
settings. 
 

http://www.swsoft.com/en/products/sitebuilder/win/docs/
http://www.swsoft.com/en/products/sitebuilder3win/docs
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Configuring ASP.NET for Your Domain 

Most ASP.NET configuration settings that commonly need to be customized in order 
for ASP.NET applications to function in a desirable way can be edited through Plesk. 

 To configure ASP.NET for your domain: 

1 Click ASP.NET on your home page. 

2 Set up the strings that determine database connection data for 
ASP.NET applications which use databases. This option is available 
only for ASP.NET 2.0.x. 

When you open the ASP.NET configuration page for the first time, sample 
connection parameters with common constructions are displayed. You can then 
delete them and specify your own strings. 

 To add a string, enter the required data into the Name and Connection Parameters 

input fields and click  next to them. 

 To remove a string, click  next to it. 

3 Set up custom error messages that will be returned by ASP.NET 
applications in the Custom Error Settings field: 

 To set the custom error messages mode, select an appropriate option from the 
Custom error mode menu: 

 On - custom error messages are enabled. 

 Off - custom error messages are disabled and detailed errors are to be 
shown. 

 RemoteOnly - custom error messages are displayed only to remote clients, 
and ASP.NET errors are shown to the local host. 

 To add a new custom error message (which will be applied unless the Off mode 
was selected), enter the values in the Status Code and Redirect URL fields, and 

click . 

 Status Code defines the HTTP status code resulting in redirection to the error 
page. 

 Redirect URL defines the web address of the error page presenting 
information about the error to the client. 

Due to possible conflicts, you cannot add a new custom error message with an 
error code that already exists, but you can redefine the URL for the existing 
code. 

 To remove a custom error message from the list, click  next to it. 

4 Configure compilation settings in the Compilation and Debugging field: 

 To determine the programming language to be used as default in dynamic 
compilation files, choose an entry from Page default language list. 

 To enable compiling retail binaries, leave the Switch on debugging checkbox 
empty. 
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 To enable compiling debug binaries, select the Switch on debugging checkbox. In 
this case, the source code fragments containing error will be shown in a 
diagnostic page message. 

Note. When running applications in debug mode, a memory and/or performance 
overhead occurs. It is recommended to use debugging when testing an application 
and to disable it before deploying the application into production scenario. 

5 Configure encoding settings for ASP.NET applications in the 
Globalization Settings section: 

 To set an adopted encoding of all incoming requests, enter an encoding value 
into the Request encoding field (default is utf-8). 

 To set an adopted encoding of all responses, enter an encoding value into the 
Response encoding field (default is utf-8). 

 To set an encoding which must be used by default for parsing of .aspx, .asmx, 

and .asax files, enter an encoding value into the File encoding field (default is 

Windows-1252). 

 To set a culture which must be used by default for processing incoming web 
requests, select an appropriate item from the Culture list. 

 To set a culture which must be used by default when processing searches for a 
locale-dependent resource, select an appropriate item from the UI Culture list. 

6 Set a code access security trust level for ASP.NET applications in the 
Code Access Security field. 

CAS trust level is a security zone to which applications execution is assigned, 
defining what server resources the applications will have access to. 

Important. When an assembly is assigned a trust level that is too low, it does not 
function correctly. For more information on the permissions levels see 
http://msdn.microsoft.com/library/en-
us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010. 

7 Enable the usage of the auxiliary scripts in the Script Library Settings 
field. Specifying the script library settings is necessary if the validation 
web controls are used on your web site. This option is available only 
for ASP.NET 1.1.x. 

 If you need to use auxiliary scripts (specifically, scripts implementing objects for 
validating input data), provide the settings for .NET framework script library. To 
do so, enter the path beginning with the domain root directory preceded by the 
forward slash into the Path to Microsoft script library field, or click the folder icon 
next to the Path to Microsoft script library field and browse for the required location. 

 To initiate the auto-installation of files containing the scripts to the specified 
location, select the Install checkbox. If the files already exist there, they will be 
rewritten. 

8 Set client session parameters in the Session Settings field: 

 To set up the default authentication mode for applications, select an appropriate 
item from the Authentication mode list. Windows authentication mode should be 
selected if any form of IIS authentication is used. 

 To set up time that a session can idle before it is abandoned, enter appropriate 
number minutes into the Session timeout field. 

http://msdn.microsoft.com/library/en-us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010
http://msdn.microsoft.com/library/en-us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010


 

 Setting Up And Maintaining Your Web Site 38 

 

9 Сlick OK to apply all changes. 

Note: Plesk supports separate configurations for different versions of the .NET 

framework (1.1.x and 2.0.x). 
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Configuring ASP.NET for Virtual Directories 

To improve the performance of ASP.NET-based web applications, Plesk allows using 
individual settings of .NET framework per virtual directory. 

 To configure ASP.NET for a virtual directory: 

1 Click Web Directories on your home page. 

2 Browse to the required directory and enter it.   

3 Click ASP.NET. 

4 Set up the strings that determine database connection data for 
ASP.NET applications which use databases. This option is available 
only for ASP.NET 2.0.x. 

When you open the ASP.NET configuration page for the first time, sample 
connection parameters with common constructions are displayed. You can then 
delete them and specify your own strings. 

 To add a string, enter the required data into the Name and Connection Parameters 

input fields and click  next to them. 

 To remove a string, click  next to it. 

5 Set up custom error messages that will be returned by ASP.NET 
applications in the Custom Error Settings field: 

 To set the custom error messages mode, select an appropriate option from the 
Custom error mode menu: 

 On - custom error messages are enabled. 

 Off - custom error messages are disabled and detailed errors are to be 
shown. 

 RemoteOnly - custom error messages are displayed only to remote clients, 
and ASP.NET errors are shown to the local host. 

 To add a new custom error message (which will be applied unless the Off mode 
was selected), enter the values in the Status Code and Redirect URL fields, and 

click . 

 Status Code defines the HTTP status code resulting in redirection to the error 
page. 

 Redirect URL defines the web address of the error page presenting 
information about the error to the client. 

Due to possible conflicts, you cannot add a new custom error message with an 
error code that already exists, but you can redefine the URL for the existing 
code. 

 To remove a custom error message from the list, click  next to it. 

6 Configure compilation settings in the Compilation and Debugging field: 

 To determine the programming language to be used as default in dynamic 
compilation files, choose an entry from Page default language list. 
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 To enable compiling retail binaries, leave the Switch on debugging checkbox 
empty. 

 To enable compiling debug binaries, select the Switch on debugging checkbox. In 
this case, the source code fragments containing error will be shown in a 
diagnostic page message. 

Note. When running applications in debug mode, a memory and/or performance 
overhead occurs. It is recommended to use debugging when testing an application 
and to disable it before deploying the application into production scenario. 

7 Configure encoding settings for ASP.NET applications in the 
Globalization Settings section: 

 To set an adopted encoding of all incoming requests, enter an encoding value 
into the Request encoding field (default is utf-8). 

 To set an adopted encoding of all responses, enter an encoding value into the 
Response encoding field (default is utf-8). 

 To set an encoding which must be used by default for parsing of .aspx, .asmx, 

and .asax files, enter an encoding value into the File encoding field (default is 

Windows-1252). 

 To set a culture which must be used by default for processing incoming web 
requests, select an appropriate item from the Culture list. 

 To set a culture which must be used by default when processing searches for a 
locale-dependent resource, select an appropriate item from the UI Culture list. 

8 Set a code access security trust level for ASP.NET applications in the 
Code Access Security field. 

CAS trust level is a security zone to which applications execution is assigned, 
defining what server resources the applications will have access to. 

Important. When an assembly is assigned a trust level that is too low, it does not 
function correctly. For more information on the permissions levels see 
http://msdn.microsoft.com/library/en-
us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010. 

9 Enable the usage of the auxiliary scripts in the Script Library Settings 
field. Specifying the script library settings is necessary if the validation 
web controls are used on your web site. This option is available only 
for ASP.NET 1.1.x. 

 If you need to use auxiliary scripts (specifically, scripts implementing objects for 
validating input data), provide the settings for .NET framework script library. To 
do so, enter the path beginning with the domain root directory preceded by the 
forward slash into the Path to Microsoft script library field, or click the folder icon 
next to the Path to Microsoft script library field and browse for the required location. 

 To initiate the auto-installation of files containing the scripts to the specified 
location, select the Install checkbox. If the files already exist there, they will be 
rewritten. 

10 Set client session parameters in the Session Settings field: 

 To set up the default authentication mode for applications, select an appropriate 
item from the Authentication mode list. Windows authentication mode should be 
selected if any form of IIS authentication is used. 

http://msdn.microsoft.com/library/en-us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010
http://msdn.microsoft.com/library/en-us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010
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 To set up time that a session can idle before it is abandoned, enter appropriate 
number minutes into the Session timeout field. 

11 Сlick OK to apply all changes. 

Note: Plesk supports separate configurations for different versions of the .NET 
framework (1.1.x and 2.0.x). 
 

Restoring Default ASP.NET Configuration 

 To restore the default ASP.NET configuration: 

1 Click ASP.NET on your home page. 

2 Click Set to Default. 

3 Confirm the restoring and click OK. 
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Changing .NET Framework Version for Your Domain 

 To change the version of .NET framework used by your domain: 

1 Click ASP.NET on your home page. 

2 Click Change Version in the Tools group. If this button is absent, only one 
version of .NET framework is available. You can see the version 
number in the Framework Version field. 

3 Select the required version number and click OK. 

4 Click OK to save changes. 

Alternatively, you can click  Setup on your home page and select the .NET 
framework version in the Microsoft ASP.NET support drop-down menu. 

Changing .NET Framework Version for a Virtual (Web) Directory 

In order to provide running ASP.NET applications which use different .NET framework 
versions within one domain, Plesk allows setting up the framework version per virtual 
(web) directory, where the applications are deployed.  

 To choose the version of .NET framework for a virtual (web) directory: 

1 Click Web Directories in on your home page. 

2 Enter the required web directory and click ASP.NET in the Tools group. 

3 Select the required .NET framework version and adjust other settings 
as necessary. 

4 Click OK. 

 

 
 

Setting PHP Version for Your Domain 

 To set PHP version for your domain:  

1 On your Home page, click PHP Settings. 

2 Choose the required version of PHP and click OK. 
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Deploying Databases 

If your web server incorporates data processing applications or is designed to generate 
web pages dynamically, you will likely need a database for storing and retrieving data. 
You can either create a new database for your site or import the data from your 
previously backed up MySQL or Microsoft SQL Server database. 
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Creating and Importing Databases 

 To create a new database on your hosting account: 

1 On your Home page, click Databases. 

2 Click Add New Database. 

3 Enter a name for the database.  

We recommend that you choose a name that starts with a Latin alphabet symbol 
and comprises only alphanumeric and underscore symbols (up to 64 symbols).  

4 Select the database type that you are going to use:  MySQL or Microsoft 
SQL Server. Click OK. 

5 To set up database administrator’s credentials, click Add New Database 
User. 

6 Type a user name and a password that will be used for accessing the 
contents of the database. 

7 Click OK.   

 

 To import an existing database: 

1 On your Home page, click Databases. 

2 Click Add New Database. 

3 Enter a name for the database.  

We recommend that you choose a name that starts with a Latin alphabet symbol 
and comprises only alphanumeric and underscore symbols (up to 64 symbols).  

4 Select the database type that you are going to use: MySQL or Microsoft 
SQL Server. Click OK. 

5 To set up database administrator’s credentials, click Add New Database 
User. 

6 Type a user name and a password that will be used for accessing the 
contents of the database. Click OK. 

7 Click WebAdmin in the Tools group. An interface to phpMyAdmin (or 
ASPEnterpriseManager) database management tool will open in a 
separate browser window. 

If you have a MySQL database: 

1. Click Query window in the left frame, click the Import files tab,  

2. Select the text file that contains the data and click Go. 

3. Click the Insert data from a text file link. 

If you have a MS SQL database: 

1. Click the name of your database in the left frame 

2. Click Query (the magnifying glass button) 
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3. Copy the text of your script into the text area and click Run 
Query. 

To manage your databases and their contents, use your favorite MySQL or Microsoft 
SQL client or the web based database management tool accessible from Plesk control 
panel (Home > Databases > Database name > WebAdmin).  

Creating a Database User Account 

If you collaborate with other people on managing your web site and wish to give them 
access to the database, you should create separate user accounts for them. 

 To create a database user account:  

1 Go to Databases > database name and click Add New Database User. 

2 Type a user name and a password that will be used for accessing the 
contents of the database. Click OK. 

 
 

Changing Password of a Database User 

 To change password for a database user: 

1 Go to Databases > database name > database user’s name. 

2 Type a new password and click OK. 

 
 

Removing a Database User Account 

 To remove a database user account:  

1 Go to Databases > database name.  

2 Select a check box corresponding to the user account that you wish to 
remove. 

3 Click  Remove Selected. Next, confirm removing and click OK.  
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Removing a Database 

 To remove a database with its contents: 

1 On your Home page, click Databases in the Services group. 

2 Select a check box corresponding to the database that you wish to 
remove.  

If the required check box appears grayed out, this means that this database is used 
by a site application and you can remove it only by uninstalling the respective 
application. 

3 Click  Remove Selected. Confirm removal and click OK. 

 
 

Accessing Data From External Databases 

If you want to access the data from an external database management system, you 
should use Open Database Connectivity (ODBC) drivers. For example, you can install 
a Microsoft Access ODBC driver, creating a connection to external Microsoft Access 
database, and let your web applications use this database for storing their data. 

Creating Connections to External Databases by Installing New ODBC 
Drivers 

To let your web applications use external databases for storing the data, you need to 
create connections to these external databases by installing appropriate ODBC drivers. 

 To install a new ODBC driver, creating a connection to an external database: 

1 On your Home page, click the domain name you need. 

2 Click ODBC Data Sources in the Services group. 

3 Click Add New ODBC DSN. 

4 Specify the ODBC connection name and description in the 
corresponding fields. 

5 Select the required driver in the Driver field. 

6 Click OK. 

7 Choose the appropriate options on the driver configuration screen. 
Typically, you should specify the path to the database, user 
credentials and other connection options, depending on the selected 
driver. 

8 Click Test to check whether the connection will function properly with 
provided settings. Click Finish to complete the creation. 
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Changing Settings Of Existing ODBC Connections 

 To change settings of an existing ODBC connection: 

1 On your Home page, click the domain name you need. 

2 Click ODBC Data Sources in the Services group. 

3 Click the required connection name in the list. 

4 Change the settings as needed. 

5 Click Test to check whether the connection will function properly with 
new settings. Click Finish to save changes. 

 

Removing Connections to External Databases 

 To remove a redundant ODBC connection: 

1 On your Home page, click ODBC Data Sources in the Services group. 

2 Select the checkbox corresponding to a connection you want to 
remove. 

3 Click  Remove Selected, confirm the removal and click OK. 

 
 

Configuring Data Source Names for Adobe 
ColdFusion 

If you are using Adobe ColdFusion, you can configure data source names (DSNs) for 
ColdFusion through Plesk. Data name sources allow your ColdFusion web applications 
to use local and remote databases for processing and storing application data. 
 

Creating a New Data Source Name 

 To create a new Data Source Name for Adobe ColdFusion on your domain: 

1 On your home page, go to ColdFusion DSN and click Add New ColdFusion 
DSN. 

2 Specify the data source name and select the required driver for this 
data source in the Driver menu. Click Next >>. 

3 Choose the appropriate options on the driver configuration screen. 
Typically, you should specify the path to the database, user 
credentials and other connection options, depending on the selected 
driver. Refer to Adobe ColdFusion documentation for more information 
on the driver configuration options. 

4 Click OK to finish. 
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Changing Settings of a Data Source Name 

 To change the settings Data Source Name for Adobe ColdFusion on your domain: 

1 On your home page, go to ColdFusion DSN and click the required data 
source name in the list. 

2 Specify the data source name and select the required driver for this 
data source in the Driver menu. Click Next >>. 

3 Choose the appropriate options on the driver configuration screen. 
Typically, you should specify the path to the database, user 
credentials and other connection options, depending on the selected 
driver. Refer to Adobe ColdFusion documentation for more information 
on the driver configuration options. 

4 Click OK. 
 

Removing a Data Source Name 

 To remove a redundant ColdFusion DSN connection: 

1 On your home page, click ColdFusion DSN. 

2 Select the check box corresponding to a DSN connection you want to 
remove. 

3 Click  Remove Selected, confirm the removal and click OK. 
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Installing Applications 

To enhance your web site with valuable features, such as guestbooks, forums, hit 
counters, photo galleries, and e-commerce solutions, you can install the respective 
applications from Plesk Application Vault (Home > Application Vault). The number and 
variety of available applications depend on your provider’s policy and your hosting plan. 

 To install an application on your site: 

1 On your home page, click Application Vault in the Hosting group.  

A list of applications installed on your site will be displayed.  

2 Click Add New Application in the Tools group. A list of site applications 
available for installation will be displayed. 

To view help on a certain site application, click  icon. The help page containing 
the general information on this site application will open in a separate browser 
window. 

3 To specify the site where you want to install and deploy an 
application, select it in the Target domain drop-down box in the upper-
right corner of the screen. 

4 To specify which application you wish to install, select a radio button 
corresponding to the application of your choice. 

5 Click  Install. 

6 Specify whether you wish to create a hyperlink to the application’s 
interface and place it on your Home page in the control panel.  

7 Specify the installation preferences and other information that may be 
required by the application (the requirements may vary), and click OK, 
when finished. 

8 If you have chosen to create a hyperlink button inside your Plesk 
control panel, specify its properties: 

 Type the text that will show on your button in the Button label box. 

 Choose the location for your button. To place it in the right frame of your Home 
page, select the Domain Administration page value as the location. To place it in 
the left frame (navigation pane) of your control panel, select the Navigation pane 
value.    

 Specify the priority of the button. Plesk will arrange your custom buttons on the 
control panel in accordance with the priority you define: the lower the number – 
the higher is priority. Buttons are placed in the left-to-right order. 

 To use an image for a button background, type the path to its location or click 
Browse to browse for the desired file. It is recommended that you use a 16x16 
pixels GIF or JPEG image for a button to be placed in the navigation pane, and 
32x32 pixels GIF or JPEG image for buttons placed in the main frame. 

 Type the hyperlink to be attached to the button into the URL box. 
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 Using the checkboxes, specify whether to include the data, such as domain id 
and domain name to be transferred within the URL. These data can be used for 
processing by external web applications. 

 In the Context help tip contents input field, type in the help tip that will be displayed 
when you hover the mouse pointer over the button. 

 Select the Open URL in the Control Panel checkbox if you wish the destination URL 
to be opened in the control panel's right frame, otherwise leave this checkbox 
unchecked to open the URL in a separate browser window. 

 If you wish to make this button visible to the e-mail users who you granted 
access to control panel, select the Visible to all sub-logins checkbox. 

9 Click OK to complete creation. 

Now the application is installed and you can insert a link to this application into the web 
pages of your site, for example, on your home page. Otherwise, you and your users will 
have to access this application by typing its URL, which can be long enough to 
remember. 

 To access the web interface of an application, do any of the following: 

 Type the URL in your browser. For example: http://your-domain.com/forum/. 

 Go to Home > Application Vault, and click an icon , corresponding to the 
application. 

 If you chose to add a hyperlink button to your Plesk control panel during installation 
of an application, then on your Home page, click the respective button in the Custom 
buttons group or navigation pane. 

 To reconfigure an application or change the application administrator’s password: 

Go to Home > Application Vault, and click the  icon corresponding to the application. 

 To uninstall an application: 

1 Go to Home > Application Vault, and select a check box corresponding to 
the application that you no longer need.  

2 Click  Remove Selected. The application will be uninstalled and its 
databases removed from the server. 

 

If you want a certain Web-application to be started when someone tries to enter a 
domain, it can be done by creating a default domain application. 

 To set an application as default for a domain: 

1 On your home page, click Application Vault in the Hosting group. A list of 
applications installed on the site will be displayed. 

2 Select a checkbox corresponding to the Site Application name you 

want to set as default, then click  Default. Click OK to confirm the 
creation of the default Site Application. 

Now, when a user enters an URL in the address field of his browser (e.g. 
http://example.com), he is taken to the default Web-application. 

http://your-domain.com/forum/
http://example.com/
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Installing Java Web Applications 

You can install Java Web application packages in the Web archive format (WAR). 
These Java applications are not distributed with Plesk, therefore you should obtain 
them separately. 

 To install a Java Web application: 

1 From your Home page, go to Web Applications > Java Applications tab and 
click Switch On. 

This will start the Tomcat service, which provides an environment for Java code to 
run in cooperation with a web server. 

2 Click Install New Application. 

3 Specify the path to an application package you wish to install (this 
can be an application package in WAR format saved on your 
computer’s hard drive), or click Browse to navigate to it, then click OK. 

Now the application is installed and the respective entry is added to the list of installed 
Java applications (Web Applications > Java Applications). 

 To access the web interface of a Java Web application, do any of the following: 

 From your Home page, go to Web Applications > Java Applications tab, and click a 
respective hyperlink in the Path column. 

 Type the URL in your browser. For example: http://your-
domain.com:9080/storefront/. 

 To stop, start or restart a Java Web application: 

1 From your Home page, go to Web Applications > Java Applications tab. A 
list of installed applications will open. 

2 Locate an application on the list, and use the icons in the right part of 
the list to perform the required operations: 

 To start an application, click the icon . 

 To stop an application, click the icon . 

 To restart an application, click the icon . 

 To uninstall a Java Web application: 

1 From your Home page, go to Web Applications > Java Applications tab. 

2 Select a check box corresponding to the application that you no 

longer need. Click  Remove Selected, confirm the removal and click OK.  

The application will be uninstalled and its databases removed from the server. 

Installing ASP.NET Web Applications 

In addition to the applications from the Application Vault, you can install ASP.NET Web 
application packages. 

http://your-domain.com:9080/storefront/
http://your-domain.com:9080/storefront/
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 To install an application on your site: 

1 On your Home page, click ASP.NET Web Applications in the Hosting group. 

A list of applications installed on your site will be displayed.  

2 Click Install New Web Application in the Tools group. A list of site 
applications available for installation will be displayed. To specify 
which application you wish to install, select a radio button 
corresponding to the application of your choice. 

3 Click  Install. 

4 Specify the domain folder in which the application should be installed, 
database name for the application, and click Install. 

Now the application is installed and you can insert a link to this application into the web 
pages of your site, for example, on your home page. Otherwise, you and your users will 
have to access this application by typing its URL, which can be long enough to 
remember. 

 To access the web interface of an application, do any of the following: 

 Type the URL in your browser. For example: http://your-domain.com/forum/. 

 Go to Home > ASP.NET Web Applications, and click an icon  , corresponding to the 
application. 

 To reconfigure an application or change the application administrator’s password: 

Go to Home > ASP.NET Web Applications, and click an icon , corresponding to the 
application. 

 To uninstall an application:  

1 Go to Home > ASP.NET Web Applications, and select a check box 
corresponding to the application that you no longer need.  

2 Click  Remove Selected. The application will be uninstalled and its 
databases removed from the server. 

 

If you want a certain Web-application to be started when someone tries to enter a 
domain, it can be done by creating a default domain application. 

 To set an application as default for a domain: 

1 On your Home page, click ASP.NET Web Applications in the Hosting group. 
A list of application packages installed on the site will be displayed.  

2 Select a checkbox corresponding to the application package you want 

to set as default, then click  Default. Click OK to confirm the creation 
of the default Site Application. 

Now, when a user enters an URL in the address field of his browser (e.g. 
http://example.com), he is taken to the default Web-application. 

http://your-domain.com/forum/
http://example.com/
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Using IIS Application Pool 

IIS Application Pool contains all your web applications. If your service provider has 
given you a dedicated IIS application pool, it allows you to have a level of isolation 
between your web applications and web applications used by other domain owners that 
host their web sites on the same server. Because each application pool runs 
independently, errors in one application pool will not affect the applications running in 
other application pools. 

By default, the application pool is enabled.  

To stop all applications running in the application pool, click IIS Application Pool on your 
Home page and click Stop. 

To start all applications in the application pool, click IIS Application Pool on your Home 
page and click Start. 

To restart all applications running in the application pool, click IIS Application Pool on 
your Home page and click Recycle. This can be handy if some applications are known 
to have memory leaks or become unstable after working for a long time. 

Setting Up IIS Application Pool 

 To enable IIS application pool for a domain: 

1 Click IIS Application Pool on your Home page. 

2 Click Switch On. 

3 To limit the amount of CPU resources that your application pool can 
use, select the Switch on CPU monitoring checkbox and provide a number 
(in percents) in the Maximum CPU use (%) field. 

4 Click OK. 

Once you enable the application pool, all your web applications will be using it. 

Disabling IIS Application Pool 

 To disable IIS application pool for a domain: 

1 Click IIS Application Pool on your Home page. 

2 Click Switch Off. 

3 Click OK. 
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Customizing DNS Zone Configuration for 
Your Domain 

Your control panel automatically creates DNS zone for your domain in accordance with 
the configuration preset defined by your provider. The domain name should work fine 
with the automatic configuration, however if you need to perform custom modifications 
in the domain name zone, you can do that through your control panel. 

To view the resource records in a DNS zone of your domain, click DNS Settings in the 
Services group. A screen will show all resource records for your domain. 

To learn about modifying resource records in the DNS zone of a domain alias, refer to 
the Setting Up Additional Domain Names for a Site (Domain Aliases) (on page 70) 
section. 

Adding Resource Records 

 To add a new resource record to the zone: 

1 Click DNS Settings in the Services group. 

2 Click Add Record in the Tools group. 

3 Select a resource record type, and specify the appropriate data: 

 For an A record you will need to enter the domain name for which you wish to 
create an A record. If you are simply defining an A record for your domain, then 
you should leave the available field empty. If you are defining an A record for a 
name server then you will need to input the appropriate entry for the given name 
server (ie. ns1). Then, you need to enter the appropriate IP address to which to 
associate the domain name. 

 For a NS record, you will need to enter the domain name for which you wish to 
create the NS record. If you are defining an NS record for your domain, then you 
will leave the available field blank. Then enter the appropriate name server 
name in the field provided. You will need to enter the complete name (i.e. 
ns1.mynameserver.com). 

 For a MX record, you will need to enter the domain for which you are creating 
the MX record. For your domain, you would simply leave the available field 
blank. You will then need to enter your mail exchanger, this is the name of the 
mail server. If you are running a remote mail server named 
'mail.myhostname.com' then you would simply enter 'mail.myhostname.com' 
into the field provided. You will then need to set the priority for the mail 
exchanger. Select the priority using the drop-down box: 0 is the highest and 50 
is the lowest. Keep in mind you would also need to add the appropriate A 
record, and/or CNAME if applicable for the remote mail exchange server. 

 For a CNAME record, you will need to first enter the alias domain name for 
which you wish to create the CNAME record. You then need to enter the domain 
name within which you want the alias to reside. Any domain name can be 
entered. It does not need to reside on the same server. 
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 For a PTR record you will first enter the IP address/mask for which you wish to 
define the pointer. Then enter the appropriate domain name for this IP to be 
translated to. 

 For a TXT record, you will be able to enter an arbitrary text string, which could 
be a description or an SPF record. 

 For a SRV record, you will need to enter the service name, protocol name, port 
number, and target host. Service and protocol names should start with the 
underline symbol. You can also specify the priority of service and weight of 
service in the appropriate fields.  

4 Click OK to submit the data.  

 
 

Modifying Resource Records 

 To modify the properties of a resource record: 

1 Click the DNS Settings icon in the Services group. 

2 Click the hyperlink in the Host column corresponding to the resource 
record you want to modify. 

3 Modify the record as required and click OK. 

 

 To modify the entries in the Start of Authority (SOA) record for a domain: 

1 Click DNS Settings in the Services group. 

2 Select SOA Settings tab. 

3 Specify the desired values: 

 Refresh Interval. This is how often the secondary name servers check with the 
primary name server to see if any changes have been made to the domain's 
zone file. Plesk sets the default value of three hours. 

 Retry Interval. This is the time a secondary server waits before retrying a failed 
zone transfer. This time is typically less than the refresh interval. Plesk sets the 
default value of one hour. 

 Expire Interval. This is the time before a secondary server stops responding to 
queries, after a lapsed refresh interval where the zone was not refreshed or 
updated. Plesk sets the default value of one week. 

 Minimum TTL. This is the time a secondary server should cache a negative 
response. Plesk sets the default value of one day. 

 Default TTL. This is the amount of time that other DNS servers should store the 
record in a cache. Plesk sets the default value of one day. 

4 Click OK. 
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Modifying Common Access Control List (ACL) 

You can modify the common Access Control List (ACL) via Plesk. ACL contains all 
hosts to which DNS zone transfers for all zones are allowed. 

 To modify the common Access Control List (ACL) for a domain: 

1 Click DNS Settings in the Services group. 

2 Select Transfer Restrictions tab. 

 To add a network to ACL, specify the IP address and mask in the IP address/mask 
field and click Add Network. 

 To delete a network from ACL, select the checkbox corresponding to the required 

network in the list, click  Remove Selected, confirm the removal and click OK. 
 

Removing Resource Records 

 To remove a resource record from the zone: 

1 Click DNS Settings in the Services group. 

2 Select a check box corresponding to the record you wish to remove. 

3 Click  Remove Selected. Confirm removal and click OK. 

 
 

Restoring the Original Zone Configuration 

 To restore the original zone configuration in accordance with the configuration preset 
defined by your provider: 

1 Click DNS Settings in the Services group. 

2 Click Restore Defaults. 

3 In the IP address drop-down box, select the IP address to be used for 
restoring the zone and specify whether a www alias is required for the 
domain.  

4 Confirm the restoration and click OK. The zone configuration will be 
recreated. 

 

 To reset the entries in the Start of Authority (SOA) record to default settings: 

1 Click DNS Settings in the Services group. 

2 Select the SOA Records tab. 

3 Click Restore Defaults. 
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Serving Your Site with External Domain Name 
Servers 

If you host a web site on this server and have a standalone DNS server acting as a 
primary (master) name server for your site, you may want to set up your control panel's 
DNS server to function as a secondary (slave) name server: 

1 Go to DNS Settings. 

2 Click Switch DNS Service Mode in the Tools group. 

3 Click Add Record, specify the IP address of the primary (master) DNS 
server, and click OK. 

 

 To make the control panel’s DNS server act as a primary for a zone: 

1 Click DNS Settings. 

2 Click Switch DNS Service Mode in the Tools group. The original resource 
records for the zone will be restored. 

 

If you host a web site on this server and rely entirely on other machines to perform the 
Domain Name Service for your site (there are two external name servers - a primary 
and a secondary), switch off the control panel’s DNS service for each site served by 
external name servers: 

1 Click DNS Settings. 

2 Click Switch Off the DNS Service in the Tools group. Turning the DNS 
service off for the zone will refresh the screen, so that only a list of 
name servers remains. 

Note: The listed name server records have no effect on the system. They are only 
presented on the screen as clickable links to give you a chance to validate the 
configuration of the zone maintained on the external authoritative name servers. 

 To validate the configuration of a zone maintained on authoritative name servers: 

1 Click DNS Settings. 

2 Add the entries pointing to the appropriate name servers that are 
authoritative for the zone to the list of DNS records: c lick Add Record, 
specify a name server, and click OK. Repeat this for each name server 
you would like to test.  

3 The records will appear in the list. 

4 Click on the records that you have just created. Plesk will retrieve the 
zone file from a remote name server and check the resource records 
to make sure that domain’s resources are properly resolved.  

5 The results will be interpreted and displayed on the screen. 
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Customizing Web Server Error Messages 

When visitors coming to your site request pages that the web server cannot find, the 
web server generates and displays a standard HTML page with an error message. The 
standard error messages may inform of problems, but they do not usually say how to 
resolve them or how to get the lost visitor on his way, and they also look dull. 

You may want to create your own error pages and use them on your web server. With 
Plesk you can customize the following error messages: 

 400 Bad File Request. Usually means the syntax used in the URL is incorrect (e.g., 
uppercase letter should be lowercase letter; wrong punctuation marks). 

 401 Unauthorized. Server is looking for some encryption key from the client and is 
not getting it. Also, wrong password may have been entered. 

 403 Forbidden/Access denied. Similar to 401; a special permission is needed to 
access the site – a password and/or username if it is a registration issue. 

 404 Not Found. Server cannot find the requested file. File has either been moved or 
deleted, or the wrong URL or document name was entered. This is the most 
common error. 

 500 Internal Server Error. Could not retrieve the HTML document because of 
server-configuration problems. 

 To configure Plesk’s web server to show your custom error pages: 

1 Switch on support for custom error documents through Plesk.  

1. On your Home page click Setup.  

2. Select the Custom Error Documents check box.  

3. Click OK. 

2 Click Web Directories on your Home page to see the list of error 
documents for the root web directory (error documents located here 
are used for all domain web pages). If you want to customize error 
pages for a certain web directory, go to that directory.  

3 Click Error Documents tab and click the required error document in the 
list. 

 To use the default document provided by IIS for this error page, select Default in 
the Type menu. 

 To use a custom HTML document already located in the error_docs directory 

on a domain, select File in the Type menu and specify the file name in the 
Location field.  

 To use a custom HTML document located in directory other than error_docs 

on a domain, select URL in the Type menu and enter the path to your document 
in the Location field. The path should be relative to the virtual host root (that is, 

<vhosts>\<domain>\httpdocs). 
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For example, you have created a file forbidden_403_1.html and saved it in 

the my_errors directory located in the httpdocs. To use this file as an error 

document, the following path should be entered in the Location filed: 

/my_errors/forbidden_403_1.html. 

Note. You can use both FTP and File Manager to upload your custom error 
document to the server. By default, all error documents are stored in the 

/vhosts/your-domain.com/error_docs/ directory. 

4 Once the web server is restarted, it will start using your error 
documents. 

 

Organizing Your Site Structure With 
Subdomains 

Subdomains are additional domain names that enable you to: 

 Organize logically the structure of your web site 

 Host additional web sites or parts of your web site on the same server without the 
need to pay for registration of additional domain names 

An example of using subdomains: 

You have a web site your-product.com dedicated to promoting your software product. 
For publishing user’s guides, tutorials and list of frequently asked questions, you can 
organize the subdomain 'userdocs' so that your users will be able to access online user 
documentation directly by visiting the domain name userdocs.your-product.com. 
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Setting Up Subdomains 

 To set up a subdomain: 

1 Click Subdomains on your home page. 

2 Click Add New Subdomain. 

3 Select the required Hosting type and click OK: 

 Select Physical hosting to create a virtual host for the domain. 

 Select Subdomain on subfolder to create a virtual subdomain.  Subdomain on 
subfolder will use physical structure of the domain. The creation of a separate 
FTP user account will be not possible: the FTP user account of the domain will 
be used.     

4 Type the subdomain name as required. This can be, for example, a 
topic of a site, organization department, or any other combination of 
letters, numbers and hyphens (up to 63 characters in length). To add 
the WWW prefix, select the appropriate checkbox. 

The subdomain name must begin with an alphabet character. Subdomain names 
are case insensitive. 

5 If you are creating subdomain on subfoler, specify the physical 
location for the subdomain files in the Site home directory field: 

 Clear the Create physical directory for subdomain checkbox and specify the existing 

directory to the right of httpdocs field. You can click  to browse for the required 
directory, select it and click OK. 

 Leave the Create physical directory for subdomain checkbox selected to create a 
corresponding physical directory with the same name as the subdomain. 

6 If you are creating subdomain with physical hosting, specify the FTP 
user account for it: 

 If this subdomain will hold a part of your own Web site that you manage on your 
own, leave the Use the FTP user account of the main domain option selected.  

 If this subdomain will hold a separate web site that will belong to or will be 
managed by another person, select the Create a separate user account for this 
subdomain option, and specify the login name and password that will be used for 
accessing the web space through FTP and publishing web site content. Specify 
the hard disc quota in the appropriate field in megabytes or leave the Unlimited 
checkbox selected. When the specified limit is exceeded, you will not be able to 
add files to the web space, and editing existing files may corrupt them. 

7 Leave the Publish site with SiteBuilder checkbox selected to be able to 
access SiteBuilder and build web site through your Plesk control  
panel interface. When the Publish site with SiteBuilder option is selected, a 
site will be created in SiteBuilder. All publishing parameters will be set 
in the paths predefined: for subdomain with Physical hosting - 
/subdomains/SUBDOMAINNAME/httpdocs/sitebuilder; for subdomain 
with Subdomain on subfolder - /httpdocs/SUBDOMAINNAME/. 
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8 If you want to enable Microsoft FrontPage support, select the appropriate 
checkbox. Enable or disable Remote Microsoft FrontPage authoring by 
selecting the appropriate option.    

9 Specify the programming languages support in the Services group by 
selecting the required languages. Use select all or clear all to select or 
clear all of the languages available. 

If the ASP.NET support is disabled on the domain for which you are creating 
subdomain, it is also unavailable on Subdomain on subfolder. In case the ASP.NET 
support is enabled on the domain, the ASP.NET is available for subdomain created 
on a subfolder.  

10 Select the Additional write/modify permissions option if this subdomain's 
web applications will use a file-based database (like Jet) located in 

the root of httpdocs or httpsdocs folders. Please note that 

selecting this option might seriously compromise the web site 
security. 

11 To complete the setup, click OK. It may take up to 48 hours for the 
information on new subdomain to spread in the Domain Name System 
and become available to the Internet users. 

 

To publish web content to the subdomain’s web space, follow the instruction presented 
in the Publishing Your Site (on page 25) section. 

To preview the web content published under the subdomain, on your Home page, click 

Subdomains, and then click the  icon corresponding to the subdomain name. 

Removing Subdomains 

 To remove a subdomain with its web content: 

1 On your Home page, click Subdomains. 

2 Select a check box corresponding to the subdomain name that you 
wish to remove.   

3 Click   Remove Selected. Confirm removal and click OK. 

The subdomain configuration and its web content will be removed from the server. 
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Setting Up Anonymous FTP Access to the 
Server 

If you host your site on a dedicated IP address, you can set up a directory within the 
site, where other users will be able to anonymously download or upload files through 
FTP. Once anonymous FTP is enabled, the users will be able to log in to the 
ftp://ftp.your-domain.com with the "anonymous" login name and any password. 

 To allow anonymous FTP access: 

1 On your Home page, click the domain name you need. 

2 Click FTP Management in the Hosting group. 

3 Click the Anonymous FTP tab. 

4 To activate anonymous FTP service, click Switch On. 

5 To set up a welcoming message to be displayed when users log in to 
FTP site, select the Display login message check box and type the 
message text in the input field as desired.  

Note that not all FTP clients display welcoming messages. 

6 To allow visitors to upload files to the /incoming directory, select the 
Allow uploading to incoming directory check box. 

7 To allow users to create subdirectories in the /incoming directory, 
select the Allow creation of directories in the incoming directory check box. 

8 To allow downloading files from the /incoming directory, select the 
Allow downloading from the incoming directory checkbox. 

9 To limit the amount of disk space that can be occupied by uploaded 
files, deselect the Unlimited check box corresponding to the Limit disk 
space in the incoming directory option, and specify the amount in kilobytes.  

This is the hard quota: the users will not be able to add more files to the directory 
when the limit is reached. 

10 To limit the number of simultaneous connections to the anonymous 
FTP server, deselect the Unlimited check box corresponding to the Limit 
number of simultaneous connections option and specify the number of 
allowed connections. 

11 To limit the bandwidth for anonymous FTP connections, deselect the 
Unlimited check box corresponding to the  Limit download bandwidth for this 
virtual FTP domain option and enter the maximum bandwidth in kilobytes 
per second. 

12 Click OK. 

 

 To modify settings for anonymous FTP server or switch it off: 

1 On your Home page, click the domain name you need. 

ftp://ftp.your-domain.com/
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2 Click FTP Management in the Hosting group. 

3 Click the Anonymous FTP tab. 

4 Adjust the settings as required and click OK.  

5 To switch off the anonymous FTP, click Switch Off in the Tools group. 
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Using Virtual Directories 

A virtual directory in Plesk is a link to existing physical directory that is present on the 
server's hard disk. Virtual directories can have a number of specific settings like custom 
ASP.NET configuration, access permissions, URL password protection, and so on. 

Since any virtual directory can have its own settings, including customized ASP.NET 
configuration, virtual directories are very useful in setting up your web applications, 
especially those written in ASP.NET. For example, if you have three web applications 
that use ASP.NET version 1.1, and you need to install one web application that uses 
ASP.NET version 2.0, you can create a virtual directory for the ASP.NET 2.0 
application, configure ASP.NET settings for this directory, enabling version 2.0 only for 
this directory, and successfully install the required application. 

Virtual directories can also be used as aliases. For example, you have a web 
application installed on your domain 'example.com' in the physical folder 

'/my_data/web_apps/forum'. To access this web application, users need to type 

'example.com/my_data/web_apps/forum', which is hard to remember and too 

long to type. You can create virtual directory 'forum' in the root of your virtual host, and 

link this virtual directory to '/my_data/web_apps/forum', so users who want to 

access the web application have to type 'example.com/forum' , which is much 

shorter and easier to remember. 

To open a virtual directory in your browser, click Web Directories on your Home page, 

and click the  icon corresponding to the directory you wish to open. 

Creating Virtual Directories 

 To create a new virtual directory on a domain: 

1 Click Web Directories on your Home page. You are in your web site root 
now. 

2 Navigate to the directory in which you want to create a new virtual 
directory. 

3 Click Add New Virtual Directory. 

Note. To create a physical directory instead of virtual directory, click Add New 
Directory, specify the name of the directory and click OK. 

4 Specify the required parameters: 

 Name - specify the virtual directory name. 

 Path - specify the virtual directory path: 

Select the Create physical directory with the same name as virtual directory checkbox 
to automatically create a physical directory with the same name as the virtual 
directory you are creating. 

Clear the Create physical directory with the same name as virtual directory checkbox 
and specify the path in the field to select the physical directory that already 
exists. 
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 Script source access - select this checkbox to allow users to access source code if 
either Read or Write permissions are set. Source code includes scripts in ASP 
applications. 

 Read permission - select this checkbox to allow users to read files or directories 
and their associated properties. 

 Write permission - select this checkbox to allow users to upload files and their 
associated properties to the virutal directory or to change content in a write-
enabled file. Write access is allowed only if browser supports the PUT feature of 
the HTTP 1.1 protocol. 

 Directory browsing - select this checkbox to allow users to see a hypertext listing 
of the files and subdirectories in the virtual directory.  

 Log visits - select this checkbox if you want to store the information about visits 
of the virtual directory. 

 Create application - select this checkbox to make the web directory an IIS 
Application. The directory becomes logically independent from the rest of the 
web-site. 

 Execute permissions - select the appropriate program execution level allowed for 
the virtual directory. 

None - allow access only to static files such as HTML or image files. 

Scripts only - allow running scripts only, not executables. 

Scripts and Executables - remove all restrictions so that all file types can be 
executed. 

5 Click OK to complete the creation. 

 

 To set access permissions for a virtual directory: 

1 Click Web Directories on your home page. 

2 Click the  icon corresponding to the directory you wish to open, and 
set the access permissions for this directory and all its files.  

Refer to the Setting File and Folder Access Permissions (on page 86) section for 
more information on setting access permissions. 

 To configure ASP.NET for a virtual directory:  

1 Click Web Directories on your home page. 

2 Browse to the required directory and enter it.  

3 Click ASP.NET and set the options accordingly. 

Refer to the Configuring ASP.NET for Virtual Directories (on page 39) section for more 
information on configuring ASP.NET 
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Changing Virtual Directory Settings 

 To change preferences of an existing virtual directory on a domain: 

1 Click Web Directories on your Home page. 

2 Find the directory which preferences you wish to change, and click . 

3 Click Preferences. 

4 Change the preferences of the virtual directory:  

 Name - specify virtual directory name. 

 Path - specify the path to the physical directory which virtual directory is linked 
to. 

 Script source access - select this checkbox to allow users to access source code if 
either Read or Write permissions are set. Source code includes scripts in ASP 
applications. 

 Read permission - select this checkbox to allow users to read files or directories 
and their associated properties. 

 Write permission - select this checkbox to allow users to upload files and their 
associated properties to the virutal directory or to change content in a write-
enabled file. Write access is allowed only if browser supports the PUT feature of 
the HTTP 1.1 protocol. 

 Directory browsing - select this checkbox to allow users to see a hypertext listing 
of the files and subdirectories in the virtual directory.  

 Log visits - select this checkbox if you want to store the information about visits 
of the virtual directory. 

 Create application - select this checkbox to make the web directory an IIS 
Application. The directory becomes logically independent from the rest of the 
web-site. 

 Execute permissions - select the appropriate program execution level allowed for 
the virtual directory. 

None - allow access only to static files such as HTML or image files. 

Scripts only - allow running scripts only, not executables. 

Scripts and Executables - remove all restrictions so that all file types can be 
executed. 

 Allow to use parent paths - select this checkbox to allow using double period in the 
pathname when referring to a folder above the current web directory. This 
makes users able to move up the folder tree without knowing the folder name or 
the whereabouts in the hierarchy. If the option is selected, parent path 
directories should not have the Execute permission checkbox selected in their 
preferences, so that applications do not have the ability of unauthorized running 
of programs in the parent paths. 
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 Allow application execution in MTA (multi-threaded apartment) mode - select this 
checkbox to allow the application execution in multi-threaded apartment (MTA) 
mode. Otherwise the application will run in a single-threaded apartment (STA) 
mode. Using STA, each application pool is executed in a dedicated process. 
With MTA, several concurrent application pools are executed in one thread 
which can increase performance in some cases. 

 Use default documents - select this checkbox to allow the use of default 
documents for the current web directory. The default document is sent when 
users access the directory on the Web without a specific file name (e.g. using 
'http://www.swsoft.com' as opposed to 'http://www.swsoft.com/index.html'). If 
this checkbox is cleared and the Directory browsing checkbox is selected, the 
Web server returns a folder listing. If this checkbox is cleared and the Directory 
browsing checkbox is cleared as well, the Web server returns an "Access 
Forbidden" error message. 

 Default documents search order - specifies the order in which IIS searches for the 
default document, sending user the first available file it finds. If no match is 
found, IIS behaves as in the cases when the default content page is disabled. 

 Allow anonymous access - select this checkbox if you want to make the directory 
public so that web users could access it without authentication. 

 Require SSL - select this checkbox to enable SSL-only access to the folder. 

5 Click OK to save changes. 

 

 To change access permissions for a virtual directory: 

1 Click Web Directories on your home page. 

2 Click the  icon corresponding to the directory you wish to open, and 
change the access permissions for this directory and all its files.  

Refer to the Setting File and Folder Access Permissions (on page 86) section for 
more information on setting access permissions. 

 To reconfigure ASP.NET for a virtual directory:  

1 Click Web Directories on your home page. 

2 Browse to the required directory and enter it.  

3 Click ASP.NET and change the options accordingly. 

Refer to the Configuring ASP.NET for Virtual Directories (on page 39) section for 
more information on configuring ASP.NET 
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Adding and Removing MIME Types 

Multipurpose Internet Mail Exchange (MIME) types instruct a Web browser or mail 
application how to handle files received from a server. For example, when a Web 
browser requests an item on a server, it also requests the MIME type of the object. 
Some MIME types, like graphics, can be displayed inside the browser. Others, such as 
word processing documents, require an external helper application to be displayed. 

When a web server delivers a Web page to a client Web browser, it also sends the 
MIME type of the data it is sending. If there is an attached or embedded file in a 
specific format, IIS also tells the client application the MIME type of the embedded or 
attached file. The client application then knows how to process or display the data 
being received from IIS. 

IIS can only operate files of registered MIME types. These types could be defined both 
on the global IIS level and on the domain or virtual directory level. Globally defined 
MIME types are inherited by all the domains and virtual directories while ones defined 
on the domain or virtual directory level are used only for the area where they are 
defined. Otherwise, if the web server receives request for a file with unregistered MIME 
type, it returns the 404.3 (Not Found) error. 

Adding New MIME Types 

 To add a new MIME type for a virtual directory on a domain: 

1 Click Web Directories on your Home page 

2 Navigate to the required virtual directory and enter it.  

3 Select the MIME Types tab. 

4 Click Add New MIME Type. 

 Type the filename extension in the Extension field. Filename extention should 
begin with a dot (.), or a wildcard (*) to serve all files regardless of filename 
extension. 

 Specify the file content type in the Content field.  

 You can either select the appropriate value from the list or define a new content 
type. To do this, select Custom... and enter the content type in the input box 
provided. 

5 Click OK to finish the creation. 
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Changing MIME Type Settings 

 To edit an existing MIME type for a virtual directory on a domain: 

1 Click  Web Directories on your Home page 

2 Navigate to the required virtual directory and enter it.  

3 Select the MIME Types tab. 

4 Select the required MIME type in the list.  

 Type the filename extension in the Extension field. Filename extention should 
begin with a dot (.), or a wildcard (*) to serve all files regardless of filename 
extension. 

 Specify the file content type in the Content field.  

 You can either select the appropriate value from the list or define a new content 
type. To do this, select Custom... and enter the content type in the input box 
provided. 

5 Click OK to save changes. 

 
 

Removing MIME Types 

 To remove a MIME type from a virtual directory on a domain: 

1 Click  Web Directories on your Home page 

2 Navigate to the required virtual directory and enter it. 

3 Select the MIME Types tab. 

4 Select the checkbox corresponding to the MIME type you wish to 
remove.  

5 Click  Remove Selected. 

6 Confirm removal and click OK. 

 
 

Setting PHP Version for Virtual Directories 

In addition to be able to choose the PHP version you would like to use on your domain, 
you also have the additional ability to specify the PHP version for any given virtual 
directory on your domain, allowing you to use web applications that require PHP4 as 
well as PHP5. 

 To set PHP version for a virtual directory:  

1 Click Web Directories on your home page. 

2 Click PHP Settings. 

3 Choose the required version of PHP and click OK. 
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Removing Virtual Directories 

 To remove an existing virtual directory: 

1 Click  Web Directories on your Home page. 

2 Select the checkbox corresponding to the directory you wish to 
remove. 

3 Click   Remove Selected. 

4 Confirm the removal and click OK. 

 
 

Setting Up Additional Domain Names for a 
Site (Domain Aliases) 

If you have registered with a domain name registrar several domain names that you 
would like to point to the same web site that you host on this server, you should set up 
domain aliases, as described in this chapter. 
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Setting Up a Domain Alias 

 To set up a domain alias: 

1 Go to Domain Aliases and click Add Domain Alias. 

2 Type the desired domain alias name, for example alias.com.  

Domain aliases can comprise letters, digits and hyphens. Each part of the domain 
alias between dots should not be longer than 63 symbols. 

3 Select the Synchronize DNS zone with the primary domain check box if you 
want the domain alias to use the same DNS zone resource records as 
in primary domain. With this setting, any subsequent changes in 
resource records of the primary domain's zone will be applied to the 
DNS zone of this domain alias.    

4 Select the Mail check box, if you want e-mail directed at the e-mail 
addresses under the domain alias to be redirected to the e-mail 
addresses under your original domain name. 

Example: You have an e-mail address mail@yourdomain.com. You have set up an 
alias for your domain name, for example, alias.com. If you want to receive mail to 
your mailbox mail@yourdomain.com when it is sent to mail@alias.com, select the 
Mail check box. 

5 Select the Web check box. Otherwise, the web server will not serve the 
web content to users coming to your site by typing the domain alias in 
their browsers. 

6 Select the Java Web applications check box if you have Java applications 
installed on your site and you want them to be accessible through the 
domain alias. 

7 Click OK. 

 
 

mailto:mail@yourdomain.com
mailto:mail@yourdomain.com
mailto:mail@alias.com
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Modifying Properties of a Domain Alias 

 To change the properties of an alias:  

1 Go to Domain Aliases and click the alias name you need. 

2 Change the properties and click OK. 

 

 To modify resource records in the DNS zone of a domain alias: 

1 Go to Domain Aliases and click the alias name you need. 

2 Click DNS Settings. 

3 Add, edit or remove the resource records as required: 

 To add a resource record to the zone, click Add New Record. Specify the required 
values and click OK to write the values to the zone. 

 To modify a resource record, under the Host column, click a hyperlink 
corresponding to the record you need. 

 To remove a record, select a check box corresponding to the record you wish to 

remove and click  Remove Selected. 

To learn more about DNS resource records modification and other DNS-related 
options, refer to the Customizing DNS Zone Configuration for Your Domain (on page 
54) and the Serving Your Site with External Domain Name Servers (on page 57) 
sections. 

Removing a Domain Alias 

 To remove an alias from a domain:  

1 Click Domain Aliases on your home page. 

2 Select a check box corresponding to the domain alias that you want to 
remove. 

3 Click  Remove Selected. Confirm removal and click OK. 
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Hosting Personal Web Pages on Your Web 
Server 

You can host on your Web server personal Web pages for individuals who do not need 
their own domain names. This service is popular with educational institutions that host 
non-commercial personal pages of their students and staff. 

These pages usually have web addresses like http://your-domain.com/~username, 
however, you can set up personal web pages with alternative web addresses like 
http://username@your-domain.com, if you like. 

 To accommodate a personal web page on your server, allocate a separate web space 
and set up an FTP account for publishing: 

1 On your Home page, click Web Users. 

2 Click Preferences. 

3 If you wish to allow access to personal web pages by alternative web 
addresses like http://username@your-domain.com, select the Allow 
webuser@example.com access format check box. 

By default, personal web pages have addresses like http://your-
domain.com/~username.  

4 If you wish to allow execution of scripts embedded in personal web 
pages, select the Allow the web users scripting check box. 

5 Click OK.  

The settings you have defined at the steps 3 and 4 are common for all personal 
web pages you might host on your web server. Therefore, you will not need to 
perform steps 3 and 4 next time you set up a web space for a personal web page. 

6 Click Add New Web User. 

7 Specify a user name and password that will be used for accessing the 
web space through FTP and publishing the web page.  

You can use only lowercase alphanumeric, hyphen and underscore symbols in user 
name. The user name should begin with an alphabet character. It cannot contain 
white spaces. The password cannot contain quotation marks, white space, user's 
login name, and should be between 5 and 14 characters in length.   

8 If you wish to limit the amount of disk space that can be occupied by 
the Web page content, clear the Unlimited checkbox and type the 
desired value in megabytes into the Hard disk quota box.  

When the specified limit is exceeded, the Web page owner will not be able to add 
files to his or her web space. 

9 Select the Additional write/modify permissions option if this web user's web 
applications will use a file-based database (like Jet) located in the 

root of httpdocs or httpsdocs folders. Please note that selecting 

this option might seriously compromise the web site security.  

http://your-domain.com/~username
http://username@your-domain.com/
http://username@your-domain.com/
mailto:webuser@example.com
http://your-domain.com/~username
http://your-domain.com/~username
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10 Specify the programming languages that should be supported for the 
Web page.  

For example, if the web page is written in PHP, select the PHP support check box. 

11  Click OK. 

Now you can tell your user the FTP account credentials, so that he or she can publish 
their web page. 
 

Changing FTP Password for a Web Page Owner 

 To change FTP password for a web page owner: 

1 Go to Web Users > user name. 

2 Type the new password into the New password and Confirm password 
boxes. 

3 Click OK. 

 
 

Allocating More Disk Space to the Web Page Owner 

 To allocate more disk space to the web page owner: 

1 Go to Web Users > user name. 

2 Type the amount of disk space in megabytes into the Hard disk quota 
box. 

3 Click OK. 

 
 

Removing Web Page Owner's Account 

 To remove a web page owner’s account together with his or her web page: 

1 On your Home page, click Web Users. 

2 Select a check box to the right of the user name you wish to remove.  

3 Click  Remove Selected. Confirm removal and click OK. 

 
 



 

 Setting Up And Maintaining Your Web Site 75 

 

Renaming Your Domain 

 To rename your domain: 

1 Click Rename Domain on your Home page. 

2 Type a new name for a domain in the Domain name field. Leave the www 
check box selected if you wish to allow users to access your site by a 
common URL like www.your-domain.com.  

Having the www alias preceding your domain name will not cost you anything, but it 
will allow users to get to your site no matter what they type in their browsers: 
www.your-domain.com and your-domain.com will both point to your site. 

3 Click OK. The operation might take several minutes, during which all 
domain services will be stopped. 

Since domain renaming involves modifying DNS records, allow up to 48 hours for DNS 
propagation after the renaming. 

http://www.your-domain.com/
http://www.your-domain.com/
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In this chapter you will find out how to increase the security of your web site and its 
data. 

In this chapter: 

Securing Online Transactions on Your Site With SSL Encryption ...................... 77 
Restricting Bandwidth Usage for Your Domain .................................................. 83 
Restricting the Amount of Simultaneous Web Connections to Your Domain ..... 83 
Protecting Your Site From Bandwidth Stealing (Hotlinking) ............................... 84 
Restricting Access to Web Server's Resources With Password Protection ........ 85 
Setting File and Folder Access Permissions ...................................................... 86 
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Securing Online Transactions on Your Site 
With SSL Encryption 

If you are running an e-commerce business, you need to secure transactions between 
your customers and your site. To prevent the valuable data, such as credit card 
numbers and other personally identifiable information from stealing, you should use the 
Secure Sockets Layer protocol, which encrypts all data and transfers them securely 
over the SSL connection. And even if someone intercepts the data for malicious intent, 
they will not be able to decrypt and use them. 

To implement the Secure Sockets Layer protocol on your web server, you should 
purchase an SSL certificate from a reputable certificate vendor (these vendors are 
called Certificate Authorities), and then install this certificate on your site. To enable 
SSL protection, you must host your site on a dedicated IP address, which is not shared 
among other web sites. 

There are numerous certificate authorities to choose from. When considering one, pay 
attention to reputation and credibility of the CA. Knowing how long they have been in 
business and how many customers they have will help you make the right choice. 

Your Plesk control panel provides facilities for purchasing SSL certificates from 
GeoTrust, Inc. 

Obtaining and Installing SSL Certificates from GeoTrust, Inc. 

 To purchase an SSL certificate through MyPleskCom online store and secure your 
site: 

1 Go to Certificates and click Add New Certificate. 

2 Specify the certificate properties: 

 Certificate name. This will help you identify this certificate in the repository. 

 Encryption level. Choose the encryption level of your SSL certificate. We 
recommend that you choose a value more than 1024 bit. 

 Specify your location and organization name. The values you enter should not 
exceed the length of 64 symbols. 

 Specify the domain name for which you wish to purchase an SSL certificate. 
This should be a fully qualified domain name. Example: www.your-domain.com 

 Enter the domain administrator's e-mail address. 

3 Make sure that all the provided information is correct and accurate, as 
it will be used to generate your private key. Click Buy Certificate.  

Your private key and certificate signing request will be generated — do not delete 
them. MyPlesk.com login page will open in a new browser window. 

4 Register or login to an existing MyPlesk.com account and you will be 
taken step by step through the certificate purchase procedure. 

5 Choose the type of certif icate that you wish to purchase. 

http://www.your-domain.com/
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6 Click Proceed to Buy and order the certificate.  

7 In the Approver E-Mail drop-down box, please select the correct 
Approver e-mail.  

The approver e-mail is an e-mail address that can confirm that certificate for 
specific domain name was requested by an authorized person. 

Once your certificate request is processed, GeoTrust, Inc. will send you a 
confirmation e-mail. After they receive the confirmation from you, they will send the 
certificate to your e-mail. 

8 When you receive your SSL certificate, save it on your local machine 
or network. 

9 Return to the SSL Certificates repository (Home > Certificates). 

10 Click Browse and navigate to the location of the saved certificate.  

11 Select the saved certificate, and then click Send File.  

This will upload and install the certificate against the corresponding private key. 

12 Return to your Home page and click Setup in the Hosting group. 

13 Select the SSL certificate that you wish to install from the Certificate 
drop-down box.  

If there is no Certificate drop-down box on the screen, this means that you are on a 
shared hosting account; therefore, you need to upgrade your hosting package and 
purchase a dedicated IP address from your hosting provider. 

14 Select the SSL support check box and click OK. 
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Obtaining and Installing SSL Certificates from Other Certification 
Authorities 

 To secure your site with an SSL certificate from other certificate authorities: 

1 Go to Certificates and click Add New Certificate. 

2 Specify the certificate properties: 

 Certificate name. This will help you identify this certificate in the repository. 

 Encryption level. Choose the encryption level of your SSL certificate. We 
recommend that you choose a value more than 1024 bit. 

 Specify your location and organization name. The values you enter should not 
exceed the length of 64 symbols. 

 Specify the domain name for which you wish to purchase an SSL certificate. 
This should be a fully qualified domain name. Example: www.your-domain.com 

 Enter the domain administrator's e-mail address. 

3 Make sure that all the provided information is correct and accurate, as 
it will be used to generate your private key. Click Request. 

 Your private key and certificate signing request will be generated and stored in the 
repository. 

4 Click , download the certificate signing request (CSR) file and save 
it on your machine. 

5 Once downloaded, open the file in a text editor, copy the text 
enclosed in lines -----BEGIN CERTIFICATE REQUEST----- and -----
END CERTIFICATE REQUEST----- to the clipboard. 

6 Using your favorite mail client software, create a new e-mail message 
and paste the text from the clipboard.  

7 Send this message to the Certification Authority that will create an 
SSL certificate in accordance with the information you supplied. 

8 When you receive your SSL certificate, save it on your local machine 
or network. 

9 Return to the SSL Certificates repository (Home > Certificates). 

10 Click Browse in the middle of the page and navigate to the location of 
the saved certificate.  

11 Select it, and then click Send File.  

This will upload and install the certificate against the corresponding private key. 

12 Return to your Home page and click Setup in the Hosting group. 

13 Select the SSL certificate that you wish to install from the Certificate 
drop-down box.  

If there is no Certificate drop-down box on the screen, this means that you are on a 
shared hosting account; therefore, you need to upgrade your hosting package and 
purchase a dedicated IP address from your hosting provider. 

14 Select the SSL support check box and click OK. 
 

http://www.your-domain.com/
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Creating and Installing Free Self-signed SSL Certificate 

If you do not feel like paying money for SSL certificates, but still need to secure your 
site, you can create a self-signed certificate and install it on your web server. This will 
provide data encryption; however, your customers’ browsers will show warning 
messages telling that your certificate is not issued by a recognized authority. Thus, 
using self-signed certificates is not recommended as it will not instill confidence in 
customers, and is likely to adversely affect your online sales. 

 To secure your site with a self-signed SSL certificate: 

1 Go to Certificates and click Add New Certificate. 

2 Specify the certificate properties: 

 Certificate name. This will help you identify this certificate in the repository. 

 Encryption level. Choose the encryption level of your SSL certificate. We 
recommend that you choose a value more than 1024 bit. 

 Specify your location and organization name. The values you enter should not 
exceed the length of 64 symbols. 

 Specify the domain name for which you wish to generate an SSL certificate. 
This should be a fully qualified domain name. Example: www.your-domain.com. 

 Enter the domain administrator's e-mail address. 

3 Click Self-Signed.  

Your certificate will be generated and stored in the repository. 

4 Return to your Home page and click Setup in the Hosting group. 

5 Select the self-signed SSL certificate from the Certificate drop-down 
box.  

If there is no Certificate drop-down box on the screen, this means that you are on a 
shared hosting account; therefore, you need to upgrade your hosting package and 
purchase a dedicated IP address from your hosting provider. 

6 Select the SSL support check box and click OK. 
 

http://www.your-domain.com/
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Uninstalling a Certificate from Your Site 

 To uninstall a certificate from your site and disable SSL protection: 

1 Make sure that the certificate you want to remove is not used at the 
moment.  

1. On your Home page, click Setup.  

2. The Certificate drop-down box indicates which SSL certificate is 
currently used.  

3. If the certificate that you want to remove is currently in use, 
you should first release it by selecting another certificate in 
the Certificate drop-down box, and clicking OK.  

2 Remove the certificate from repository.  

1. To permanently remove the certificate from repository, on your 
Home page, click Certificates in the Services group.  

2. Select a check box corresponding to the certificate that you no 

longer need and click  Remove Selected. Confirm removal and 
click OK. 

3 Disable SSL support if you no longer need it.  

1. On your Home page, click Setup.  

2. Clear the SSL support check box and click OK. 
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Using SSL Certificate Shared By Another Domain (Shared SSL) 

Shared SSL is a means of securing the access to your site with SSL (Secure Sockets 
Layer) without purchasing your own SSL certificate. Websites that employ shared SSL 
are, in fact, using the certificate shared by another domain. The domain that shares its 
SSL certificate with others is called Master SSL Domain. 

Note. In order to use shared SSL, the Master SSL Domain should be set by your 
server administrator. 

 To use SSL certificate of the Master SSL Domain, enabling shared SSL use: 

1 Click Shared SSL on your Home page. 

2 Select the Switch on shared SSL checkbox.  

3 Specify the virtual directory name in the corresponding input field. 
The virtual directory with the supplied name will be created on the 
Master SSL Domain. This directory will be used for accessing your 
site through SSL. 

For example, let us suppose that you have a domain named mydomain.com, 
Master SSL Domain is defined as master_ssl_domain.com, and the virtual directory 

name you supplied is my_virtual_dir. In this case, to access your site through 

SSL, you need to use the following address: 
https://master_ssl_domain.com/my_virtual_dir.  

Note. You cannot use your domain name (e.g., mydomain.com) to access your site 
via SSL if you are using shared SSL. 

4 Select the directory where protected content is located on your 
domain. The documents within specified directory will be accessible 

only through SSL. You can only choose either httpdocs or 

httpsdocs as a target directory. 

5 To make your domain accessible via SSL only, select the Require SSL 
checkbox. 

6 Click OK. 

 

 To stop using SSL certificate of the Master SSL Domain, disabling shared SSL use: 

1 Click   Shared SSL on your Home page. 

2 Clear the Switch on shared SSL checkbox. 

3 Click OK. 
 

https://master_ssl_domain.com/my_virtual_dir
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Restricting Bandwidth Usage for Your Domain 

To avoid excessive usage of bandwidth, which can lead to resources overage, you can 
limit bandwidth usage for your domain. 

 To limit the bandwidth for a domain: 

1 Click Performance on your Home page. 

2 Select the Switch on bandwidth throttling checkbox. 

3 Input the maximum speed (measured in KB per second) that a domain 
can share between all its connections in the Maximum network use (KB/S) 
field. 

4 Click OK. 
 

Restricting the Amount of Simultaneous Web 
Connections to Your Domain 

To avoid Denial Of Service attacks and to prevent excessive usage of bandwidth, you 
can set a limit of maximum number of simultaneous web connections your domain can 
have. 

 To limit the maximum number of simultaneous web connections to a domain: 

1 Click Performance on your Home page. 

2 Select the Switch on connections limiting checkbox.  

3 Input the maximum number of simultaneous connections in the 
Connections limited to field. 

4 Click OK. 
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Protecting Your Site From Bandwidth Stealing 
(Hotlinking) 

Hotlinking (also called file leeching, remote linking, direct linking, bandiwidth stealing or 
bandwidth banditism) is a term used for describing a situation when a web page of one 
domain owner is directly linking to images (or other multimedia files) on the web host of 
another domain owner, usually using an <IMG> tag. If your domain is hotlinked, you 
may face the problem of excessive bandwidth usage.  

 To protect your domain from hotlinking:  

1 Click Hotlink Protection on your Home page. 

2 Click Switch On to enable the protection from hotlinking.  

3 Specify the extensions of files you wish to be protected from 
hotlinking (e.g. jpg, bmp, etc) in the Protected files extensions field. When 
listing several file extensions, separate them with spaces.  

4 Click OK. 
 

Allowing and Disallowing Domains to Directly Link to Your Domain 
Files 

You can also allow and disallow certain domains to directly link to your domain files. 

 To allow a domain directly link to your domain files: 

1 Click Hotlink Protection on your Home page. 

2 Input the domain name in the Friendly domains field. 

3 Click Add. 

4 Repeat steps 2 and 3 to add other domains, if necessary, and click OK 
when finished. 

 

 To disallow a domain directly link to your domain files: 

1 Click Hotlink Protection on your Home page. 

2 Select the domain in the Friendly domains field. 

3 Click Remove. 

4 Сlick OK. 
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Restricting Access to Web Server's 
Resources With Password Protection 

If you have URLs on your site that only authorized users should see, restrict access to 
these URLs with password protection. 

Protecting a Resource 

 To password protect an URL on your site and to specify authorized users: 

1 On your Home page, click Web Directories in the Hosting group. 

2 On the General tab, click the required name from the Web directories 

list and select the Protection tab. Alternatively, you can click the  icon 
corresponding to the directory you want to protect.  

3 Click Protect to set up a protection.  

4 To add an authorized users, click Add New User in the Tools group. 

5 Specify the login name and password that will be used for accessing 
the protected area. The password should be from 5 to 14 symbols in 
length. Click OK.   

6 Click Preferences to type a a resource description or a welcoming 
message that your users will see when they visit your protected area 
in the Realm access text input field. Click OK.  

To add more authorized users for this protected resource, repeat the steps 5 and 6. 

Adding and Removing Authorized Users 

 To add an authorized user of a protected URL: 

1 On your Home page, click Web Directories in the Hosting group. 

2 On the General tab, click the required name from the Web directories 

list and select the Protection tab. Alternatively, you can click the  icon 
corresponding to the required directory. 

3 Click Add New User in the Tools group. 

4 Specify the login name and password that will be used for accessing 
the protected area. The password should be from 5 to 14 symbols in 
length. 

5 Click OK. 

 

 To change password for an authorized user of a protected URL: 

1 On your Home page, click  Web Directories in the Hosting group. 



 

 Securing Your Web Site 86 

 

2 On the General tab, click the required name from the Web directories 

list and select the Protection tab. Alternatively, you can click the  icon 
corresponding to the required directory. 

3 Click the user's name from the Protected URL users list.  

4 Specify the new password and confirm it. 

5 Click OK. 

 

 To revoke a permission to access the protected URL from a user: 

1 On your Home page, click Web Directories in the Hosting group. 

2 On the General tab, click the required name from the Web directories 

list and select the Protection tab. Alternatively, you can click the  icon 
corresponding to the required directory. 

3 Select a check box corresponding to the user’s name. 

4 Click  Remove Selected. Confirm the operation and click OK. 
 

Unprotecting a Resource 

 To remove password protection and make the resource available to the public: 

1 On your Home page, click the Web Directories in the Hosting group. 

2 On the General tab, click the required name from the Web directories 

list and select the Protection tab. Alternatively, you can click the  icon 
corresponding to the required directory. 

3 Select a check box corresponding to the name of the directory, from 
which you want to remove protection. 

4 Click  Remove Selected. The protection will be removed and the 
contents of the directory will be accessible to the public without 
restrictions. 

 

Setting File and Folder Access Permissions 

Plesk provides setting up file and folder access permissions, including defining special 
permissions and permissions inheritance, similarly to the way it is presented in 
Windows interface. 

Note. For security reasons, permissions for Administrators, SYSTEM and Plesk 
Domain Administrator cannot be changed or removed. 
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Setting and Changing Access Permissions for Groups and Users 

 To set or change access permissions for a group or user: 

1 Click File Manager on your Home page. 

2 Click  corresponding to the required file or folder. 

 To change or remove permissions from a group or user, click the required name 
in the Group or user names list. 

 To set permissions for a group or user, which is not in the Group or user names 
list, select the required user/group name from the drop-down box located above 

the list and click : the user/group appears in the list. Select it. 

3 To allow or deny permissions to a selected group/user, select the 
Allow or Deny checkboxes corresponding to permissions listed under 
Permissions for [user/group name]. 

Note. If check boxes in Allow and/or Deny columns are shaded, it means that the 
corresponding permissions are inherited from a parent folder. 

 To deny the permission, which are inherited from a parent object as allowed, 
select the required checkboxes under Deny. This will override inherited 
permissions for this file/folder. 

 To allow the permission, which are inherited from a parent object as denied, 
clear the Allow inheritable permissions from the parent to propagate to this object and all 
child objects. Include these with entries explicitly defined here checkbox: this removes 
the inherited permissions. Then select the required check boxes under Allow and 
Deny. 

4 Click OK. 
 

Removing Access Permissions from Groups and Users 

 To remove access permissions from a group or user: 

1 Click File Manager on your Home page. 

2 Click  corresponding to the required file or folder. 

3 Select the required name in the Group or user names list and click  next 
to it. 

Note: The  icons appear unavailable for entries with permissions inherited from a 
parent object. 

4 Select the required entry. 

5 Clear the Allow inheritable permissions from the parent to propagate to this object 
and all child objects. Include these with entries explicitly defined here checkbox. 

6 Select the entry again and click . 

7 Click OK. 
 



 

 Securing Your Web Site 88 

 

Setting Up Access Permissions Inheritance for Files and Folders 

 To set up access permissions inheritance for files and folders: 

1 Click File Manager on your Home page. 

2 Click  corresponding to the required file or folder. 

3 To make the file/folder inherit permissions from a parent folder (if it 
does not), select the Allow inheritable permissions from the parent to propagate 
to this object and all child objects. Include these with entries explicitly defined here 
checkbox. 

4 To make the files and folders, which are contained in this folder, 
inherit the folder permissions defined here, select the Replace permission 
entries on all child objects with entries shown here that apply to child objects 
checkbox. 

5 Click OK. 
 

Setting, Changing and Removing Special Access Permissions 

You can also set, change and remove special permissions including advanced 
management of folder permissions inheritance. In Advanced permissions management 
mode, several permission entries can be associated with a single group or user, each 
containing different set of permissions. Also, the list of permissions in Advanced mode is 
more detailed and gives more opportunities for fine-tuning file/folder permissions. It 
contains permissions that cannot be seen in Microsoft Windows interface, but present 
combinations of native Microsoft Windows permissions. They are Read Control, Write 
Control, and Execute Control. 

 To set, change or remove file/folder special permissions: 

1 Click File Manager on your Home page. 

2 Click  corresponding to the required file or folder. 

3 Click Advanced. 

 To create a permission entry for a group or user, select the required name from 

the Group or user names list and click . 

 To set or change file/folder permissions for a group or user, select the required 
name from the Group or user names list, select the required Allow and Deny 
checkboxes corresponding to permissions listed under Permissions for [group/user 
name]. 

 To remove a permission entry for a group or user, select the required name from 

the Group or user names list and click . 

 To make child objects of a folder inherit its permissions defined under 
Permissions for [group/user name], select the Replace permission entries on all child 
objects with entries shown here that apply to child objects checkbox, and select 
checkboxes in the Apply onto: list which correspond to objects you want to inherit 
the permissions. 

4 Click OK. 
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Setting Access Permissions for Virtual Directories 

Access permissions can also be applied to virtual (web) directories. 

 To set access permissions for a virtual directory:  

1 Click Web Directories on your home page. 

2 Navigate the web site structure and click the required directory.  

3 Click Permissions in the Tools group and set access permissions for this 
virtual directory, as described in the sections above. 
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You can use a number of different e-mail services with a single e-mail account. For 
example, you can have an e-mail address that will accept mail as any standard 
mailbox, forward to a number of recipients, and send an automatic response to the 
original message sender. 

In this chapter: 

Creating Mailboxes............................................................................................ 91 
Setting Up Your E-mail Program for Retrieving Mail From Your Mailbox ........... 93 
Accessing Your Mail From a Web Browser........................................................ 94 
Protecting Mailboxes From Spam ...................................................................... 95 
Protecting Mailboxes From Viruses ................................................................... 99 
Suspending and Unsuspending Mailboxes ........................................................ 100 
Removing Mailboxes ......................................................................................... 100 
Switching off the Mailbox Service When You Have Decided to Turn Your Account 
into a Mail Forwarder ......................................................................................... 101 
Setting Up Mail Forwarding to a Single E-mail Address ..................................... 102 
Setting Up Mail Forwarding to Multiple E-mail Addresses.................................. 104 
Removing Mail Forwarders ................................................................................ 106 
Setting Up Automatic Reply ............................................................................... 107 
Switching off Automatic Reply ........................................................................... 108 
Setting Up Site-wide Preferences for Handling Mail to Nonexistent Users ......... 109 
Introducing Changes to a Number of Mail Accounts at Once ............................. 109 
Maintaining Mailing Lists ................................................................................... 110 
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Creating Mailboxes 

If you wish to have an e-mail address associated with your site, like yourname@your-
domain.com, you should create a mailbox. To do this: 

1 Go to Mail and click Add New Mail Account. 

2 Your domain name is shown to the right of @ sign, so you only need 
to specify the desired name for the mailbox.  

This can be, for example, your first name and last name separated by a dot, a 
department name, or any other text in Latin symbols. The name should be short 
enough to remember. It can comprise alphanumeric, dash, dot and underscore 
symbols. 

3 Specify a password that you will use for accessing your mailbox.  

4 Make sure that a check mark is present in the Mailbox check box. 

5 Click OK. 

Now your mailbox is created on the provider’s server, and you can set up your favorite 
e-mail program so as to receive and send e-mail messages through your new mailbox. 

 To create mailboxes for other users: 

1 Go to Mail and click Add New Mail Account. 

2 Your domain name is shown to the right of @ sign, so you only need 
to specify the desired name for the mailbox.  

This can be, for example, user’s first name and last name separated by a dot, a 
department name, or any other text in Latin symbols. The name should be short 
enough to remember. It can comprise alphanumeric, dash dot and underscore 
symbols. 

3 Specify a password that mailbox owner will use for accessing his or 
her mailbox. 

4 Make sure that a check mark is present in the Mailbox check box. 

5 If required, limit the amount of disk space that this mailbox can use. 
To do this, under Mailbox quota select the Enter size option and type the 
desired value in kilobytes. 

6 To allow the mailbox owner to manage his or her mailbox through a 
mailbox administration panel, select the Control panel access check box 
and specify the language for the user’s control panel.   

7 Click OK. 

8 To allow the mailbox owner configure and use spam filter and 
antivirus, click Permissions, select the respective check boxes and click 
OK. 

 

mailto:yourname@your-domain.com
mailto:yourname@your-domain.com
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Now, the mailbox is created, and a separate e-mail administration panel has been set 
up in Plesk. To enter it, the mailbox owner should visit the URL https://your-
domain.com:8443, type his or her e-mail address into the Login box, type the password 
for the mailbox into the Password box, and then click Login. 
 

https://your-domain.com:8443/
https://your-domain.com:8443/
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Setting Up Your E-mail Program for Retrieving 
Mail From Your Mailbox 

 To set up Microsoft Outlook Express: 

1 Open Microsoft Outlook Express. 

2 Go to Tools > Accounts. 

3 Click the Mail tab to open a list of your mail accounts. 

4 Click the Add > button and select the Mail … item. 

5 Enter your name as you want it to appear in any messages you send, 
and click Next >. 

6 Type your e-mail address that you created through Plesk (for 
example, your.name@your-domain.com), and click Next >. 

7 Select the protocol of your incoming mail server.  

8 Specify the mail domain name as the incoming and outgoing mail 
server (for example: mail.your-domain.com), and click Next >. 

9 Type your e-mail address in the Account name box (for example: 
your.name@your-domain.com). 

10 Type your password. This should be the password that you specified 
during creation of the mailbox through Plesk.  

11 Leave the Remember password box checked, if you do not wish to be 
prompted to enter password each time your e-mail program connects 
to the mail server to check for new mail, and click Next >. 

12 To complete setting up your e-mail program, click Finish. 

 

 To set up Mozilla Thunderbird: 

1 Open Mozilla Thunderbird. 

2 Go to Tools > Account Settings… 

3 Click Add Account. The Account Wizard will open. 

4 Leave the Email account option selected, and click Next >. 

5 Enter your name as you want it to appear in any messages you send.  

6 Type your e-mail address that you created through Plesk.  

For example, your.name@your-domain.com. Click Next >. 

7 Select the protocol of your incoming mail server.  

8 Specify the mail domain name as the incoming and outgoing mail 
server (for example: mail.your-domain.com), and click Next >. 

9 In the Incoming User Name box, specify your full e-mail address (for 
example, your.name@your-domain.com), and click Next >. 

mailto:your.name@your-domain.com
mailto:your.name@your-domain.com
mailto:your.name@your-domain.com
mailto:your.name@your-domain.com
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10 Enter the name by which you would like to refer to this account (for 
example, Work Account) and click Next >. 

11 Verify that the information you entered is correct, and click Finish. 

12 Click OK to close the Account Settings wizard. 
 

Accessing Your Mail From a Web Browser 

You can read your mail and compose new messages even if you are far from your 
home or office computer. To do this, you first need to allow access to the Horde 
Webmail interface that is integrated with your control panel. Then you can work with 
your mail from any computer that is connected to the Internet and has a Web browser 
program installed. 

 To allow access to the Webmail interface: 

1 On your Home page, click the Mail icon. 

2 Click Preferences. 

3 Select the WebMail checkbox. 

4 Click OK. 

 

Note: Activation and deactivation of webmail for your domain involves modifications in 
DNS zone, therefore, there is actually a certain delay present when activating and 
deactivating webmail due to the speed of DNS registration mechanisms. 

 To access your mailbox through Webmail: 

1 Find a computer with Internet connection, for example, in an Internet 
café. 

2 Do any of the following: 

 Open a web browser, and type the URL: http://webmail.your-domain.com, 
where your-domain.com is the name of your domain. Press ENTER. A login 
screen will open. Type the user name and password that you specified during 
creation of your mailbox and click Log in. 

 Open a web browser and type the URL to access your Plesk control panel, for 
example: https://your-domain.com:8443. Press ENTER. Log in to Plesk, select 
the required domain in the list and click the Mail icon in the Services group. Then, 

click an icon  to the right of your e-mail address, or click your e-mail address 
and click Webmail. A login screen will open and your user name will be prefilled. 
Type the password that you specified during creation of your mailbox and click 
Log in. 

 
 

http://webmail.your-domain.com/
https://your-domain.com:8443/
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Protecting Mailboxes From Spam 

To protect your mailbox from undesirable correspondence, do not publish your e-mail 
address on Internet forums and switch on the server-side spam filter provided by the 
SpamAssassin software. 

When you need to publish your e-mail address, create a disposable e-mail address - e-
mail alias - for your primary e-mail address, and publish it instead. All messages sent to 
the e-mail alias will come into your mailbox. Once you start getting spam, remove that 
alias and create another one. If you have a mailbox at another domain or mail server, 
you may want to set up a disposable e-mail forwarder. 

We would advise that you do not read spam e-mails when you receive them, just delete 
them at once. Even if you have read them, do not respond to them and do not click the 
―click here to unsubscribe‖ URLs: spammers will then know that your e-mail address is 
valid and you will get even more spam. 

Setting Up Additional Disposable E-mail Addresses for Your Mailbox 
(E-mail Aliases) 

 To set up an e-mail alias for a mailbox: 

1 Go to Mail > e-mail address and click Add New Mail Alias. 

2 Type a desired name and click OK. 

The messages addressed to your additional e-mail address (e-mail alias) will get to 

your mailbox. You can see the list of currently used mail aliases by clicking  Show 
Aliases in the list of mail accounts under the domain. 

 To remove an e-mail alias from a mailbox: 

1 Go to Mail > e-mail address. 

2 Select the check box corresponding to the alias that you wish to 

remove, and click  Remove Selected. Confirm the removal and click OK. 

 
 

Setting Up Spam Filter 

If you receive undesirable correspondence to an e-mail address that you cannot or do 
not want to remove, consider setting up spam filter for your mailbox. To do this, 

 Enable SpamAssassin spam filter on your hosting account, if supported by your 
provider, and 

 Install spam filtering software of your choice to work with e-mail program on your 
home or office computer. 
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Switching on Spam Filter 

 To switch on spam filtering for a mailbox: 

1 On your Home page, click Mail in the Services group. 

2 Click the e-mail address you need. 

3 Make sure that Spam Filter is enabled: see whether the Spam Filter 
status shows On in the Info group. If it shows Off, ask your service 
provider to enable the spam filtering. 

4 Click Spam Filter. 

5 Select Switch on spam filtering checkbox. 

6 Click OK. 

7 Click Up Level to return to the mailbox management page. 

Now all the incoming mail will be filtered on the server side. By default, spam filter does 
not delete spam mail, it only adds the ―X-Spam-Flag: YES‖ and ―X-Spam-Status: Yes‖ 
headers to the message, and "*****SPAM*****" text string to the beginning of Subject 
line of each message recognized as spam. These settings are fine if you prefer to filter 
mail with a filtering program installed on your local computer – once mail has been 
retrieved from your mailbox. 

If you rely entirely on the Plesk server’s spam filter, you may configure it so as to 
automatically delete the suspicious messages as they come. To configure the spam 
filter, follow the instructions below. 

Configuring Spam Filter 

 To configure the spam filter for a mailbox: 

1 On your Home page, click Mail in the Services group. 

2 Click the e-mail address you need. 

3 Click Spam Filter in the Tools group. Configure the following settings as 
desired: 

 Use server wide settings. Select this option if your provider or server administrator 
has prepared black and/or white lists of e-mail addresses that you would like to 
use together with your own restrictions. Black list, shown under Black list group, 
includes e-mail addresses of spammers, and White list, shown under White list 
group, includes e-mail addresses of trustworthy correspondents or entities. If the 
Use server wide settings check box is grayed out, i.e. not selectable, this means 
that there are no preconfigured spam filter settings on the server. 

 Hits required for spam. This setting adjusts spam filter sensitivity. SpamAssassin 
performs a number of different tests on contents and subject line of each 
message. As a result, each message scores a number of points. The higher the 
number, the more likely a message is spam. For example, a message 
containing the text string ―BUY VIAGRA AT LOW PRICE!!!‖ in Subject line and 
message body scores 8.3 points. By default, the filter sensitivity is set so that all 
messages that score 7 or more points are classified as spam. 
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 If you receive lots of spam messages with the current setting, to make filter 
more sensitive, try setting a lesser value in the Hits required for spam box; for 
example, 6.  

 If you are missing your e-mails because your spam filter thinks they are junk, try 
reducing filter sensitivity by setting a higher value in the Hits required for spam 
box. 

Note:  To further improve spam filter accuracy, you may want to train your spam 
filter on e-mail messages you receive (see the instructions on improving accuracy 
of spam detection below).  

 What to do with spam mail. If you are sure that your spam filter is accurate, you 
may want to set the filter to automatically delete all incoming messages 
recognized as spam. To do this, select the Delete option. If you wish to filter mail 
with the software on your local computer, select the Mark as spam and store in 
mailbox option, and then specify how spam filter should mark the messages 
recognized as spam. ―X-Spam-Flag: YES‖ and ―X-Spam-Status: Yes‖ headers 
are added to the message source by default, and if you want, the spam filter will 
also include a specific text string to the beginning of Subject line. 

4 To save your changes, click OK. 

5 If you do not want to receive e-mail from specific senders, add their e-
mail addresses to the spam filter’s black list.  

 To add an entry to the black list, under Black list group, type an e-mail address 
into the E-mail pattern box. For example: address@spammers.net, 
*@spammers.net. An asterisk (*) means any combination of symbols. Click Add. 

 To remove an entry from the black list, select it and click Remove. 

6 If you want to be sure that you will not miss e-mail from specific 
senders, add their e-mail addresses to the spam filter’s white list.  

 To add an entry to the white list, under White list group, type an e-mail address 
into the E-mail pattern box. For example: address@mycompany.com, 
*@mycompany.com. An asterisk (*) means any combination of symbols. Click 
Add. 

 To remove an entry from the black list, select it and click Remove. 

7 If you want spam filter to consider some networks to be trusted: 

 Select the Trusted Networks tab. 

 To add an entry to the list, enter a network address into the fields next to 
Network/Mask and click Add. 

A network is specified by its starting IP address in the first four fields of the 
Network/Mask field group. The fifth field is for specifying network mask. It should 
be a number ranging from 1 to 32, which shows how many higher bits set to '1' 
the mask contains. For example, for the mask 255.255.255.0 you should specify 
24 as the fifth parameter. 

 To remove an entry from the list, select a network and click Remove. 

The relay hosts on trusted networks are considered not to be potentially operated 
by spammers, open relays, or open proxies. A trusted host could conceivably relay 
spam, but will not originate it, and will not forge header data. DNS blacklist checks 
will never query for hosts on these networks. 

 

mailto:address@spammers.net
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Improving Accuracy of Spam Detection 

 To improve the accuracy of spam detection: 

1 On your Home page, click Mail in the Services group. 

2 Click the e-mail address you need. 

3 Click the Spam Filter icon in the Tools group. 

4 Click the Training icon in the Tools group.  

All e-mail messages you have in your mailbox are presented on the screen. Each 
message is accompanied by an icon in the left column, which tells if a message is 

recognized as spam - , non-spam - , or not recognized at all - . If you have 
already trained your spam filter on a message and the results were recorded in the 

spam filter’s database, an icon  is shown in the right column. 

5 Train the spam filter.  

In most cases, you can tell if a message is spam by looking at its subject line and 
sender’s name. If they do not give you any clue, try looking inside the message 
using your e-mail program or Webmail interface. 

 To mark a message as spam, select the corresponding check box and click ‘It’s 
Spam!’. 

 To mark a message as not spam, select the corresponding check box and click 
‘It’s Not Spam’. 

 To remove any information on a given message from the spam filter database, 
select the corresponding check box and click ‘Forget It’. 

Once finished with training, you can remove spam e-mails from your mailbox using 
your e-mail program or Webmail interface. 

Clearing Spam Filter's Database 

If you have accidentally made your spam filter learn a great number of spam e-mails as 
non-spam or vice versa, your spam filter will likely produce incorrect results. In this 
case, clear the spam filter's database and then repeat training. 

 To clear spam filter’s database: 

1 On your Home page, click the Mail icon in the Services group. 

2 Click the e-mail address you need. 

3 Click the Spam Filter icon in the Tools group. 

4 Click the Training icon in the Tools group. 

5 Click the Clear button. 
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Switching off Spam Filter 

 To switch off spam filtering for a mailbox: 

1 On your Home page, click Mail in the Services group. 

2 Click the e-mail address you need. 

3 Click Spam Filter in the Tools group, then clear the Switch on  spam filtering 
check box, click OK and click Up Level. 

 

Protecting Mailboxes From Viruses 

To defend your system from viruses, do not open suspicious e-mail attachments, 
enable anti-virus protection on the server side, if this service is provided by your 
hosting company, and be sure to have a firewall and anti-virus software installed on 
your personal computer. Also keep your operating system up-to-date and timely install 
security hotfixes and patches. 

Switching on Anti-virus Protection 

 To switch on anti-virus protection for a mailbox: 

1 On your Home page, click Mail. 

2 Click the e-mail address you need. 

3 Click Antivirus in the Tools group. 

4 Choose the desired mail scanning mode.  You can switch on scanning 
for incoming and outgoing mail in the corresponding menus. You can 
also use default server-wide settings both for incoming and outgoing 
mail. 

5 Click OK. 

When an infected e-mail message arrives, the appropriate notice is sent to the mailbox 
owner and the message is placed into a quarantine directory on the server. Only the 
server administrator can view infected messages stored in the quarantine directory. 

Switching off Anti-virus Protection 

 To switch off anti-virus protection for a mailbox: 

1 On your Home page, click Mail. 

2 Click the e-mail address you need. 

3 Click  Antivirus in the Tools group. 

4 Choose the Do not scap for viruses option in both Incoming mail and Outgoing 
mail menus. 

5 Click OK. 
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Suspending and Unsuspending Mailboxes 

 To temporarily suspend e-mail services for a mailbox: 

1 Go to Mail > e-mail address > Mailbox. 

2 Clear the Mailbox check box. 

3 Click OK. 

 

 To resume e-mail services for a suspended mailbox: 

1 Go to Mail > e-mail address > Mailbox. 

2 Select the Mailbox check box. 

3 Click OK. 

 

 To temporarily suspend e-mail services for all mailboxes in your domain: 

1 On your Home page, click Mail. 

2 Click Switch Off in the Tools group. 

 

 To resume e-mail services for all mailboxes in your domain: 

1 On your Home page, click Mail. 

2 Click Switch On in the Tools group. 

 
 

Removing Mailboxes 

 To remove a mailbox: 

1 On your Home page, click Mail. 

2 Select a check box corresponding to the mailbox that you wish to 
remove. 

3 Click  Remove Selected. Confirm removal and click OK. 
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Switching off the Mailbox Service When You 
Have Decided to Turn Your Account into a 
Mail Forwarder 

If you are going to use your existing e-mail account as a mail forwarder or mailing list, 
you are recommended to switch off the mailbox service: a mailbox keeps all incoming 
messages and messages are not removed automatically after being forwarded. 
Therefore, if you choose to have the "mailbox + mail forwarder" configuration on your 
account, be sure to clean up the mailbox from time to time. 

 To switch off the mailbox service for your account discarding all messages in your 
mailbox: 

1 Go to Mail > e-mail address > Mailbox. 

2 Deselect the Mailbox check box. 

3 Click OK. 
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Setting Up Mail Forwarding to a Single E-mail 
Address 

 To set up an e-mail address that will accept mail and forward it to another e-mail 
address: 

1 Go to Mail and click Add New Mail Account. 

2 Specify the desired name for the mail forwarder next to Mail account 
name. 

The domain name is shown to the right of @ sign, so you only need to type the 
name. This can be, for example, your first name and last name separated by a dot, 
a department name, or any other text in Latin symbols. The name should be short 
enough to remember. It can comprise alphanumeric, dash dot and underscore 
symbols. 

3 Clear the Mailbox check box and click OK. 

4 Click Redirect in the Tools group. 

5 Select the Redirect check box. 

6 Type the destination e-mail address to which you would like to 
forward e-mail. 

7 Click OK.  

 

 To set up an e-mail address that will accept mail, pass it through the spam filter and 
then forward it to another e-mail address:  

1 Go to Mail and click Add New Mail Account. 

2 Specify the desired name for the forwarder’s e-mail address next to 
Mail account name. 

The domain name is shown to the right of @ sign, so you only need to type the 
name. This can be, for example, your first name and last name separated by a dot, 
a department name, or any other text in Latin symbols. The name should be short 
enough to remember. It can comprise alphanumeric, dash dot and underscore 
symbols. 

3 Make sure that the Mailbox check box is selected.  

Without a mailbox, you will not be able to apply spam filtering. 

4 Specify a password that will be used for accessing the mailbox. You 
will likely need to clean the contents of mailbox from time to time. 
Click OK. 

5 Configure the spam filter as described in the Setting Up Spam Filter 
(on page 95) section. 

6 Click Redirect in the Tools group. 

7 Select the Redirect check box. 
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8 Type the destination e-mail address to which you would like to 
forward e-mail. 

9 Click OK. 
 

Suspending and Unsuspending Mail Forwarders 

 To suspend a mail forwarder: 

1 Go to Mail > e-mail address > Redirect. 

2 Clear the Redirect check box. 

3 Click OK. 

 

 To unsuspend a mail forwarder: 

1 Go to Mail > e-mail address > Redirect. 

2 Select the Redirect check box. 

3 Click OK. 
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Setting Up Mail Forwarding to Multiple E-mail 
Addresses 

 To set up an e-mail address that will accept mail and forward it to multiple other e-mail 
addresses: 

1 Go to Mail and click Add New Mail Account. 

2 Specify the desired name for the mail forwarder next to Mail account 
name. 

The domain name is shown to the right of @ sign, so you only need to type the 
name. This can be, for example, your first name and last name separated by a dot, 
a department name, or any other text in Latin symbols. The name should be short 
enough to remember. It can comprise alphanumeric, dash dot and underscore 
symbols. 

3 Clear the Mailbox check box and click OK. 

4 Go to Mail Group and click Add New Member. 

You should add at least one e-mail address before enabling mail forwarding to 
several e-mail addresses. 

5 Enter the desired external e-mail address into the E-mail input field 
and/or select one or more of the listed mail accounts using check 
boxes. 

6 Click OK, then click Switch On. 
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Adding and Removing Recipient Addresses 

 To add an external e-mail address to the list of mail accounts that receive forwarded e-
mail correspondence: 

1 Go to Mail > e-mail address > Mail Group and click Add New Member. 

2 Enter the desired external e-mail address into the E-mail input field. 

3 Click OK. 

 

 To remove an external e-mail address from the list of mail accounts that receive 
forwarded e-mail correspondence: 

1 Go to Mail > e-mail address > Mail Group. 

2 Select the check box corresponding to the mail account you wish to 
remove from the list. 

3 Click  Remove Selected. Confirm removal and click OK. 

 

 To add an e-mail address registered on your server to the list of mail accounts that 
receive forwarded e-mail correspondence: 

1 Go to Mail > e-mail address > Groups. 

2 Select the required multiple e-mail forwarder in the Available mail groups 
list. 

3 Click Add >>. 

4 Click OK. 

An e-mail address registered on your server can also be added to the subscription list 
using the procedure for adding an external e-mail address (see above). 

 To remove an e-mail address registered on your server from the list of mail accounts 
that receive forwarded e-mail correspondence: 

1 Go to Mail > e-mail address > Groups. 

2 Select the required multiple e-mail forwarder in the Member of the 
following mail groups list. 

3 Click << Remove. 

4 Click OK. 

An e-mail address registered on your server can also be removed from the subscription 
list using the procedure for removing an external e-mail address (see above). 

Switching off Mail Forwarding to Multiple E-mail Addresses 

 To disable the e-mail forwarding to several e-mail addresses: 

1 Go to Mail > e-mail address > Mail Group. 
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2 Click Switch Off. 
 

Removing Mail Forwarders 

 To remove a mail forwarder: 

1 On your Home page, click Mail. 

2 Select a check box corresponding to the mail forwarder that you wish 
to remove. 

3 Click  Remove Selected. Confirm removal and click OK. 
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Setting Up Automatic Reply 

If you are going on vacation and will not be able to check your mail for a while, you may 
want to leave a vacation notice that will be automatically sent to your correspondents 
once they send e-mail to your address. This is done with automatic reply facility, also 
referred to as autoresponder. Aside from vacation notices, organizations can use 
automatic replies to notify customers that their orders or technical support requests 
were received and will soon be processed. Automatic replies can include prewritten 
messages in plain text or HTML format, and they can contain attached files as well. 

 To set up automatic reply for a mailbox: 

1 On your Home page, click Mail. 

2 Click the e-mail address, for which you wish to set up an automatic 
reply. 

3 Click Autoresponders in the Tools group. 

4 If you are not going to attach any files to the automatic reply, proceed 
to the step 5. To attach a file to the automatic reply:  

1. Click Attachment Files in the Tools group.  

2. Click Browse to locate the file, and once selected, click Send File.  

The file will be added to the attachment files storage, and you will be able to 
attach this file to a number of different automatic replies.  

3. Once finished, click  Up Level and proceed to the next step. 

5 Click Add New Autoresponder in the Tools group. 

6 Configure the automatic reply: 

1. Type a name for this automatic reply into the Autoresponder name 
box.  

For example, 'Vacation notice'. 

2. If you want this automatic reply to be sent in reply to any 
incoming e-mail message, in the Request group, leave the always 
respond option selected. If you wish to automatically reply only 
to e-mail messages that contain specific words in the message 
text or subject line, select the appropriate option, and type the 
word combination in the Request text input box. 

3. By default, the subject line of incoming e-mail will be inserted 
into the automated reply. To use a custom subject, type it into 
the Answer with subject subject input box. 

4. As your correspondents may not figure out that the message 
they received from you was an automatic response, they may 
want to respond to your auto-reply. So, you should specify 
your e-mail address as the Return address, otherwise, their 
messages will be directed at the autoresponder’s address. 
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5. Type your message in the Reply with text field. 

6. To limit the number of automated responses per day to the 
same e-mail address, enter the desired number in the Reply to 
unique e-mail address not more than input box under Limits.  

The default setting is to respond no more than ten times in one day to the same 
e-mail address. 

7. To reduce mail server load, you may want to limit the number 
of unique addresses that the autoresponder will remember. To 
do this, enter the desired number into the Store up to box. 

8. If you want your incoming mail to be forwarded to another e-
mail address while you are away, specify an e-mail address in 
the Forward request to e-mail  box. 

9. Attach your files, if needed. To do this, click the  Add New 
Attachment button, select the check box corresponding to the 
file that you previously uploaded to the attachment storage, 
and click OK. To remove an attached file from the automatic 

reply, select the corresponding checkbox, and click  Remove 
Selected. 

7 Click OK. 

8 Click Switch On in the Tools group. 

 
 

Switching off Automatic Reply 

 To switch off an automatic reply for a mailbox: 

1 Go to Mail > e-mail address > Autoresponders. 

2 Click Switch Off. 

The automatic reply is now switched off. Its configuration is not deleted from the control 
panel, so the next time you need to use this automatic reply, repeat the above 
procedure, clicking Switch On on the last step. 

 To delete an automatic reply configuration that you no longer need: 

1 Go to Mail > e-mail address > Autoresponders. 

2 Select a check box corresponding to the configuration name, and click 

 Remove Selected. Confirm the removal and click OK. 
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Setting Up Site-wide Preferences for Handling 
Mail to Nonexistent Users 

When somebody sends an e-mail message to an e-mail address that does not exist 
under your domain, the mail server, by default accepts mail, processes it, and when it 
finds out that there is no such a recipient under the domain, it returns the mail back to 
sender with the ―this address no longer accepts mail‖ notice. You can choose to: 

 Change the default notice if you do not like it, 

 Forward all such mail to the desired e-mail address,  

 Reject such mail without accepting it and without notifying senders.  

This setting can decrease mail server load caused by a large amount of spam, 
which is often sent to randomly generated user names. However, for spammers, 
this can somewhat speed up scanning your mail server for valid e-mail addresses. 

 To configure the site-wide settings for serving mail to nonexistent users:  

1 Go to Mail > Preferences. 

2 Choose a desired option and specify the information as required.  

3 Click OK. 

 
 

Introducing Changes to a Number of Mail 
Accounts at Once 

 To introduce similar changes to a number of mail accounts at once: 

1 Click Mail in the Services group. 

2 Select the check boxes corresponding to the mail accounts whose 
settings you want to modify. 

3 Click  Group Operations. 

4 Adjust the settings as necessary: 

 Select Switch on to enable the corresponding option for the selected mail 
accounts. 

 Select Switch off to disable the corresponding option for the selected mail 
accounts. 

 Leave Do not change selected if you do not want to change the corresponding 
option. 

5 Click OK. 
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Maintaining Mailing Lists 

If you wish to deliver offers and promotions to your customers, run a newsletter, or 
inform visitors of your site of recent updates, you should set up a mailing list on your 
site and subscribe your users to it or invite them to subscribe themselves. 

Mailing list is a convenient way to reach a number of readers at once: it contains a list 
of subscribers’ e-mail addresses, which are combined under a single e-mail address, to 
which you post your information or a newsletter. 

 
 

Setting Up a Mailing List 

 To set up a mailing list: 

1 On your Home page, click the Mail icon in the Services group. 

2 Click the Mailing lists tab. 

3 Click Add New Mailing List in the Tools group. 

4 Specify the desired name for the mailing list.  

This can be, for example, a department name, a topic of the mailing list, or any 
other text in Latin symbols. The name should be short enough to remember. It can 
comprise alphanumeric, dash, dot and underscore symbols. 

5 Specify the mailing list administrator’s e-mail. 

6 Leave the Notify administrator of the mailing list creation check box selected. 

You will receive instructions on using and managing the mailing list at the 
administrator’s e-mail you specified. Keep that message for your records. 

7 Click OK.  

You will be taken to the page where you can subscribe users to your new mailing list. 
Refer to Subscribing and Unsubscribing Users (on page 111) section for more 
information. 
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Configuring Mailing List 

Your mailing list is operable with the default settings. However, you may want to 
configure it, for example, so as to enable moderation, filter content of the posts or to 
archive messages. To do this from the control panel: 

1 On your Home page, click the Mail icon in the Services group. 

2 Click the Mailing lists tab. 

3 Click  next to the desired mailing list’s e-mail address. Note that this 
functionality might be disabled. 

A login screen opens. 

4 Type the list administrator’s password and click Let me in …. 

 

Alternately, you can access the mailing list configuration the following way: 

1 In your web browser, enter the following URL: http://lists.<your-
domain.com>/mailman/admin/<listname> (where <your-domain.com> 
is your domain name, and <listname> is the name of the mailing list 
(i.e. the left part of the mailing list’s e-mail address before the @ 
sign).  

A login screen opens.  

2 Type the list administrator’s password and click Let me in …. 

 
 

Subscribing and Unsubscribing Users 

 To subscribe users to mailing list: 

1 Go to Mail > Mailing lists tab > mailing list name and click Add New Member. 

2 Specify subscriber’s e-mail address. 

3 Click OK. 

 

 To unsubscribe users from mailing list:  

1 Go to Mail > Mailing lists tab > mailing list name. 

2 Select a check box to the left of the user’s e-mail address. 

3 Click  Remove Selected. Confirm removal and click OK. 
 



 

 Accessing The Server Via Remote Desktop (RDP) 112 

 

Posting to Your Mailing List 

To post a newsletter issue or other information to the mailing list, send it by e-mail to 
the mailing list’s e-mail address. All subscribed users will receive it. 

Removing Mailing Lists 

 To remove a mailing list from site: 

1 Go to Mail > Mailing lists tab. 

2 Select a check box corresponding to the mailing list that you wish to 
remove. 

3 Click  Remove Selected. Confirm removal and click OK. 

 
 

Accessing The Server Via Remote 
Desktop (RDP) 
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he remote desktop (RDP) access feature allows you to remotely login to the Plesk 
server and interact with it via standard Microsoft Windows desktop interface. 

 To access the server via Remote Desktop interface: 

1 On your home page, click the domain name you need. 

2 Click Remote Desktop in the Hosting group. 

3 Set up screen resolution for the session in the  Screen resolution for 
terminal session menu. 

Note: Higher resolutions are more taxing for your connection, decreasing the 

interaction speed and spending more bandwidth. 

4 Choose the connection method according to your browser:  

 Microsoft RDP ActiveX - recommended to use with Internet Explorer browser, 
since it may not work with other browsers. When you use this method for the 
first time, your browser will automatically install the required ActiveX component, 
if Internet Explorer security settings permit this. If your browser displays security 
alerts, try to temporarily lower security measures in the browser options. 

 properoJavaRDP - recommended to use with Netscape, Mozilla, or Firefox 
browsers, since it may not work with Internet Explorer. Only 8.0 and higher 
versions of Opera are supported. This component requires Java Runtime 
Environment (JRE) to be installed on your system. If you do not have JRE, you 
can download it from  http://java.sun.com/j2se/1.5.0/download.jsp (version 1.4 
and higher) and install it before using the remote desktop feature.  

Note: You don't need to install JDK (Java Development Kit) in order for the 
RDP feature to work. 

If you use Internet Explorer or Mozilla, you should open the Terminal Services 
Configuration console in the Microsoft Windows (Start > Administrative Tasks), and 
set the Licensing option to Per user on the Server Settings screen. 

5 Click OK. A new window will open with an area where your interaction 
with the server's desktop will take place. 

6 Log in to the system. By default, Plesk uses the domain's 
FTP/Microsoft FrontPage login. You can supply any valid login and 
password.  

7 After logging in to the system you can start working with it as with 
regular Windows desktop. 

 

To finish your Remote Desktop session: 

 Close the browser window with the remote desktop session. This way, the session 
you had will be detached from your desktop, but it will keep running on the server, 
so when you log in there next time, you will see the remote desktop in the state you 
left it, 

or 

 Select Start > Log off if you want to quit the session permanently (all running 
sessions consume the server's resources). 

 

http://java.sun.com/j2se/1.5.0/download.jsp
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 To choose the statistical program you want: 

1 On your Home page, click Setup. 

2 Select the statistical package you need from the Web statistics menu, 
and select the accessible via password protected directory /plesk-stat/ check 
box. 

This will install the statistical software of your choice, which will generate reports 
and place them into the password protected directory. You will then be able to 
access Web statistics at the URL: https://your-domain.com/plesk-stat/webstat using 
your FTP account login and password. 

3 Click OK. 

Note: When you switch from one statistical program to another, all reports generated 
by the previously used statistical program are removed from the server.   

To find out the amount of bandwidth and disk space used by your site, see the Disk 
Space and Traffic rows in the table at the bottom of your Home page. 

 To find out how many people visited a site, from what countries, and what pages of the 
site they viewed: 

1 Click Report in the Domain group. 

2 View the statistics for the web pages or files downloaded from or 
uploaded to specific areas of your site: 

 To view the statistics for web pages transferred from your site over hypertext 
transfer protocol (HTTP), click Web Stats. 

 To view statistics for files transferred over file transfer protocol (FTP), click FTP 
Stats. 

 To view statistics for files transferred via anonymous FTP, click Anon.FTP Stats. 

 To view the bandwidth usage by months, click Traffic History. 

 To view the bandwidth usage by FTP, Web and mail services in this domain, 
click Traffic. 

Alternately, you can view the Web statistics for a site by visiting the following URL: 
https://your-domain.com/plesk-stat. When prompted for username and password, 
specify the credentials for your FTP account. 

Common operations on reports: 

 To get more details, select the Full Report option from the Report drop-down menu. 
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 To adjust the amount of information presented in a report, click  Customize, and 
then modify an existing report template (to do this, click a report template name) or 
create a new report template (to do this, click  Add New Layout). Next, specify how 
much information you want in each section of the report: select None if you do not 
want any information, select Summary if you want a concise overview, or select Full if 
you need a detailed report. Select the Use as default report check box and click OK. 
To delete a custom report layout, select the checkbox corresponding to the report 

layout name and click  Remove Selected.  

 To print the report, click  Print. A report will open in a separate browser window. 
Select the File > Print option from the browser's menu to print the report. 

 To send the report by e-mail, type the recipient's e-mail address into the input box 

located to the right of the Report group and click  Send by E-mail. If you are the 
recipient, then you do not need to specify an e-mail address: the system assumes 
by default that you are the report recipient and specifies your e-mail address 
registered with your control panel account. 

 To have the reports automatically generated and delivered by e-mail on a daily, 
weekly, or monthly basis, click Report Delivery and follow the instructions supplied in 
the Automating Report Generation and Delivery by E-mail section. 

 

In this chapter: 

Automating Report Generation and Delivery by E-mail ...................................... 116 
Viewing Log Files and Configuring Recycling of Log Files ................................. 117 
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Automating Report Generation and Delivery 
by E-mail 

 To receive detailed reports on your domain on a regular basis: 

1 Go to Report > Report Delivery and click Add Delivery Schedule. 

2 To receive the report to your e-mail address registered with the 
system, select the the domain administrator value from the Deliver to drop-

down menu. To receive the report to another e-mail address, select 
the e-mail address I specify option and type the e-mail address.  

3 Select the delivery interval from the Delivery frequency drop-down menu. 
You can have the report delivered each day, each week, or each 
month. 

4 Click OK. 

 To change the delivery schedule for a detailed domain/web site report: 

1 Go to Report > Report Delivery. 

2 Under the Frequency column, click a hyperlink corresponding to the 
delivery schedule you would like to change. 

3 Adjust the settings as required and click OK. 

 To stop receiving the account status reports: 

1 Go to Report > Report Delivery. 

2 Select a check box corresponding to the delivery schedule and cl ick 

 Remove Selected. Confirm removal and click OK. 
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Viewing Log Files and Configuring Recycling 
of Log Files 

All connections to the Web server and requests for files that were not found on the 
server are registered in log files. These log files are analyzed by the statistical utilities 
running on the server, which then present graphical reports on demand. You may want 
to download these log files to your computer for processing by third-party statistical 
utilities, or view their contents for web server debugging purposes. 

To prevent these log files from growing too large, you should enable automatic cleanup 
and recycling of log files. 

 To enable automatic cleanup and recycling of log files: 

1 Go to Log Manager > Log Rotation and click Switch On in the Tools group. 

2 Specify when to recycle log files and how many instances of each log 
file to store on the server. Also specify whether they should be 
compressed and sent to an e-mail address after processing. 

3 Click OK. 

To view the contents of a log file or download it to your computer, click Log Manager in 
the Hosting group. A list of log files will show. 

 To specify the number of lines from the end of the log file that you would like to 
view, type a number into the input box under the Preferences group. 

 To view the contents of a log file, click its file name.  

 To download a file to your computer, click the  icon corresponding to the file you 
need.  

 To remove a processed log file from the server, select a corresponding check box, 

click  Remove Selected, confirm removal and click OK. 
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With the current version of backup and restore utilities installed with your control panel, 
you can: 

 Back up your domain (Web site). The backup archive will include all data related to 
your account (except for resource allotments and permissions to perform operations 
within the control panel), domain (web site) and mail services, including the 
contents of mailboxes, anti-spam and anti-virus settings. 

 Schedule backups.  

 Restore your data from backup archives. 

You can access your backup repository via your Home page (Home > Backup). 

In this chapter: 

Backing Up Your Domain .................................................................................. 119 
Scheduling Backups .......................................................................................... 120 
Restoring Data From Backup Archives .............................................................. 120 
Maintaining Your Backup Files Repository ........................................................ 121 
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Backing Up Your Domain 

 To back up your domain (web site): 

1 Click Backup in the Domain group. 

2 Click Create Backup in the Tools group. 

3 Specify the backup method: 

 Create backup file and store in repository - backup file is created and stored on 
Plesk server. 

 Do not store backup file in repository, only download it - backup file is created on the 
Plesk server, and as soon as it's done, you download it to your computer. After 
the download is complete, backup file is erased from Plesk server. 

 Create the backup file and store on FTP server - backup file is created on the local 
Plesk server and stored on the FTP server of your choosing. If you select this 
option, you need to specify the path to the FTP server, FTP credentials (login 
and password) and base FTP directory in the corresponding fields. 

4 Specify the backup file name in the Backup file name field and additional 
comments in the Comments field. 

5 Select the Suspend domain checkbox, if you wish to suspend all domain 
activity during the backup. Note that suspended domains aren't 
available to the visitors. 

6 Select the Nofity by e-mail checkbox and specify the e-mail, if you want 
to be notified about the backup. 

7 Click Back Up. 

8 The backup will start and the progress will be shown.  

9 Upon completion of the backup process you will be shown a window 
displaying the backup results, including errors, if they were 
encountered. Click OK. 
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Scheduling Backups 

 To schedule backup of your domain (web site): 

1 Click Backup in the Tools group. 

2 Click Scheduled Backup Settings in the Tools group. 

3 Specify when and how often to perform backup. 

4 Choose the backup repository files location:  

 Domain dumps - backup files are stored on Plesk server. 

 FTP - backup files are stored on the remote FTP.  If you select this option, you 
need to specify the path to the FTP server, FTP credentials (login and 
password) and base FTP directory in the corresponding fields on the FTP 
Account Properties page (Home > Backup > FTP Account Properties). 

5 Specify the maximum number of stored backup files in the 
corresponding field. 

6 Specify the combination of symbols that backup file names should 
begin with. This will help you distinguish between backup files.  

7 Select the Suspend domain checkbox, if you wish to suspend all domain 
activity during the backup. Note that suspended domains aren't 
available to the visitors. 

8 Click Switch On in the Tools group. 

9 Click OK. 
 

Restoring Data From Backup Archives 

 To restore your domain (Web site): 

1 Click Backup in the Tools group. 

2 Click the backup file name you need. 

3 Select the Suspend domain checkbox, if you wish to suspend all domain 
activity during the restore. Note that suspended domains aren't 
available to the visitors. 

4 Select the Nofity by e-mail checkbox and specify the e-mail, if you want 
to be notified about the restore. 

5 Click Restore. 

6 Upon completion of the restoring process you will be shown a window 
displaying the restoration results, including errors, if they were 
encountered.  

7 Click OK. 
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Maintaining Your Backup Files Repository 

Your backup files are stored in your own backup repository, accessible by clicking 
Backup on your home page. In the backup repository you can: 

 Upload backup files stored on another computer 

 Download backup files to another computer 

 Remove redundant backup files from backup repository 
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Uploading Backup Files to Server 

 To upload backup file to the backup repository: 

1 Click Backup in the Tools group. 

2 Click Browse... and select the required backup file. 

3 Click Upload. 

4 Click OK. 

The backup file will be uploaded to the backup repository. 

 To upload backup file to the backup repository from FTP: 

1 Click Backup in the Tools group. 

2 Click FTP Account Properties. 

3 Specify the path to the FTP server, FTP credentials (login and 
password) and base FTP directory in the corresponding fields.  

4 Click OK. This will return you to the previous screen. 

5 Click Browse... and select the required backup file. 

6 Click FTP Upload. 

7 Click OK. 

The backup file will be uploaded to the backup repository. 

Downloading Backup Files from Server 

 To download backup file from the backup repository: 

1 Click Backup in the Tools group. 

2 Click  corresponding to the backup file you wish to download. 

3 Select the location where you wish to save the backup file and click 
Save. 

The backup file will be downloaded from the backup repository. 

Removing Backup Files from Server 

 To remove backup file from the backup repository: 

1 Click Backup in the Tools group. 

2 Select a checkbox corresponding to the backup file you wish to 
remove. 

3 Click  Remove Selected. Confirm removal and click OK. 
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If you need to run scripts on your site at specific time, use the task scheduler on your 
provider's server to make the system automatically run the scripts for you. 

Scheduling a Task 

 To schedule a task: 

1 On your Home page, click Scheduled Tasks in the Hosting group. 

2 Click Add New Task. 

3 Input a name for your task in the Description field. 

4 In Scheduler notification, specify whether the scheduler should notify you 
when it runs this task. The following options are available:  

 Switched off - do not nofity you. 

 Send to the default e-mail - send the notification to your default e-mail address. 

 Send to the e-mail I specify - send the nofitication to the e-mail specified in the 
corresponding field. After selecting this option, you need to input the required e-
mail in the field on the right. 

5 Specify which command to run. Type it into the Path to executable file 
input box. If you need to run the command with certain options, type 
them in the Arguments field. 

6 Select the appropriate priority in the Task priority field. Task priority can 
be set to Low, Normal or High. 

7 Specify when to run your command by selecting the appropriate 
checkboxes in the Hours, Days of Month, Months or Days of Week fields. 

8 Click OK to schedule the task or click Run Now to schedule the task and 
immediately run it. 
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Suspending and Resuming Execution of 
Tasks 

 To temporarily suspend execution of scheduled task: 

1 On your Home page, click Scheduled Tasks in the Hosting group. 

2 Select the system user account on whose behalf the task is executed.  

3 Locate the task that you want to suspend and click the command 
name. 

4 Clear the Switched on check box and click OK. 

 

 To resume execution of scheduled task: 

1 On your Home page, click Scheduled Tasks in the Hosting group. 

2 Select the system user account on whose behalf the task is executed.  

3 Locate the task whose execution you want to resume and click the 
command name. 

4 Select the Switched on check box and click OK. 
 

Unscheduling a Task 

 To unschedule a task: 

1 On your Home page, click Scheduled Tasks in the Hosting group.  

2 Select the system user account on whose behalf the task is executed.  

3 Select a check box to the left of the task that you want to unschedule 

and click  Remove Selected. Confirm removal and click OK. 
 

Monitoring Connections To Control 
Panel And FTP Services 
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Monitoring Connections to Control Panel 

 To find out who of your customers is logged in to the control panel at the moment: 

1 Click Sessions in the navigation pane. All sessions including yours will 
be presented and the following details will be displayed: 

 Type. A type of control panel user who established the session:  

 for domain or Web site owner. 

 for mailbox owner. 

 Login. The login name the user is logged in as. 

 IP address. The IP address from which the control panel is accessed. 

 Logon time. The date and time when the user logged in to the control panel. 

 Idle time. The time that user was not doing anything in the control panel while 
being logged in. 

2 To refresh the list of user sessions, click Refresh. 

3 To end a user session, select the respective check box and click  
Remove Selected, then confirm removal and click OK. 
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Monitoring Connections to FTP Service 

 To find out who is connected to your server via FTP, in what directories they currently 
are and what files they are uploading to or downloading from the server: 

1 Go to Sessions and click the FTP Sessions tab. All sessions including 
yours will be presented and the following details will be displayed:  

 Type. The type of user who established the session:  

 for users not registered with the control panel. 

 for anonymous FTP users. 

 for domain or web site administrators. 

 for subdomain administrators. 

 for web users (owners of personal web pages without individual domain 
names). 

 Status. The current status of FTP connection. 

 FTP user login. The login name used for access to FTP account. 

 Domain name. The domain the FTP user is currently connected to. 

 Current location. The directory the FTP user is currently at. 

 File name. The file name being operated on. 

 Speed. Transfer speed in kilobytes. 

 Progress, %. The file transfer operation progress in percentage. 

 IP address. The IP address from which the FTP account is accessed. 

 Logon time. The time lapsed since the moment user logged in. 

 Idle time. The time that user was not doing anything while being connected to the 
server through FTP. 

2 To refresh the list of FTP sessions, click Refresh. 

3 To end a session, select the respective check box and click  Remove 
Selected. 
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If your service provider offers a Help Desk solution integrated with the control panel, 
then you can use it to report your problems to your provider’s technical support staff. 

In this chapter: 

Submitting a Problem Report to Your Service Provider ..................................... 127 
Commenting and Closing Your Trouble Ticket .................................................. 127 
 
 

Submitting a Problem Report to Your Service 
Provider 

 To submit a new problem report to your service provider: 

1 Go to Help Desk and click Add New Ticket. 

2 Type the ticket subject, select the category the issue is related to, and 
type in the problem description. 

3 Click OK.  

The ticket is now submitted to the system and sent to your provider. You will be notified 
by e-mail when the issue is resolved. 

Commenting and Closing Your Trouble Ticket 

 To post a new comment or to close a ticket: 

1 Click the Help Desk shortcut in the navigation pane. 

2 Locate the ticket you need and click its subject or identification 
number. 

3 To close, reopen or post a comment to the ticket, select the operation 
you would like to perform from the Ticket Event drop-down box, and type 
a new comment into the New Comment input field if required. 

4 Click OK to submit. 
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